# Table of Contents

INTRODUCTION ................................................................................................. 4  
What is Logi Ad Hoc Reporting? ................................................................. 5  
CHAPTER 1 Getting Started ........................................................................... 6  
   Learning the Interface ............................................................................... 7  
   Updating Your Profile ............................................................................ 11  
   Setting Your Preferences ...................................................................... 12  
   The Report Builder .................................................................................. 14  
   The Dashboard Builder ......................................................................... 22  
CHAPTER 2 Data Sources ............................................................................... 25  
   Selecting a Data Source .......................................................................... 25  
   Sorting Data ............................................................................................ 27  
   Setting Filters ......................................................................................... 29  
   Advanced Concepts in Data Filtering ...................................................... 35  
CHAPTER 3 Creating Data Columns ............................................................... 39  
   Calculated Columns .............................................................................. 39  
   Statistical Columns ............................................................................... 43  
CHAPTER 4 Tables ......................................................................................... 47  
   Configuring Table Columns .................................................................. 48  
   Grouping Data ......................................................................................... 61  
   Table Settings ....................................................................................... 75  
CHAPTER 5 Crosstabs .................................................................................... 77  
   Crosstab Configuration ......................................................................... 77  
   Crosstab Settings .................................................................................. 88  
CHAPTER 6 Charts .......................................................................................... 89  
CHAPTER 7 Interactive Data Views ............................................................... 98  
CHAPTER 8 Heat Maps .................................................................................. 107  
CHAPTER 9 Style & Formatting .................................................................... 110  
   Report Header ......................................................................................... 110  
   Adding Labels ........................................................................................ 111  
   Adding Images ....................................................................................... 112  
   Report Settings ...................................................................................... 114  
CHAPTER 10 Export Options ......................................................................... 115  
   Searchable Report .................................................................................. 118  
   Printable Paging ..................................................................................... 119  
   Export to Excel ....................................................................................... 120  
   Export to Word ....................................................................................... 121  
   Export to PDF ......................................................................................... 122  
   Export to CSV ....................................................................................... 123  
   Export to XML ...................................................................................... 124  
   Add to Archive ...................................................................................... 125  
   Send PDF Report By Email ..................................................................... 126  
CHAPTER 11 Running Reports ........................................................................ 127  
CHAPTER 12 Managing Reports ................................................................. 130
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organizing Reports</td>
<td>131</td>
</tr>
<tr>
<td>Scheduling Reports</td>
<td>134</td>
</tr>
<tr>
<td>Sharing Reports</td>
<td>139</td>
</tr>
<tr>
<td>Modifying Reports</td>
<td>140</td>
</tr>
<tr>
<td>Archiving Reports</td>
<td>141</td>
</tr>
<tr>
<td>Web Studio</td>
<td>143</td>
</tr>
<tr>
<td>View Dependencies</td>
<td>145</td>
</tr>
<tr>
<td>CHAPTER 13 Dashboards</td>
<td>146</td>
</tr>
<tr>
<td>CHAPTER 14 Multiple Data Sources</td>
<td>150</td>
</tr>
<tr>
<td>CHAPTER 15 Mobile Reports</td>
<td>152</td>
</tr>
<tr>
<td>CONTACT US</td>
<td>155</td>
</tr>
</tbody>
</table>
INTRODUCTION

The Logi Ad Hoc Report Design Guide provides information and instructions for users building reports.

The following information is included in this manual:

- Getting started
- Creating reports with the Report Builder
- Creating dashboards with the Dashboard Builder
- Viewing reports and dashboards
- Archiving, organizing, sharing and modifying reports
- Exporting reports to popular formats such as Excel, Word, PDF, CSV and XML
- Contact information

Target Audience

This guide is intended for the end-user. For additional technical documentation or support for this or any other Logi Analytics product, please visit our web site at http://www.logianalytics.com/support/.
What is Logi Ad Hoc Reporting?

Logi Ad Hoc Reporting is a web-based reporting utility designed to make building, sharing, and analyzing business intelligence reports a quick and easy process, even for non-technical users. With Ad Hoc, there is no need for downloadable report viewers, and no time or assistance is required from technical developers to easily create professional, informative reports.

Ad Hoc delivers a user-friendly interface and full-featured reporting tools. Users can create interactive charts and graphs, as well as publish comprehensive reports to share with others. An easy-to-use Report Builder walks a user through all the steps required to create comprehensive and interactive reports. It is not necessary to understand SQL or databases in order to create robust, customized reports in minutes.
CHAPTER 1
Getting Started

Open a browser window using the internet browser. Type the URL for the Ad Hoc instance in the Address bar of the browser. Bookmark the location for future reference.

The Ad Hoc login screen appears.

Logi Analytics was formerly known as LogiXML

Enter your username and password, and click LOGIN to access the application.

Notes:
1. Based on the configuration determined by the system administrator, the Login screen may be bypassed.
2. The system administrator can issue a username and password.
**Learning the Interface**

**Menu Bar**

There are six main links available in Ad Hoc in the menu bar at the top of the page:

- **Report Management** - Modify, share and run reports
- **Profile Management** - Update your user account information and preferences
- **Home** - Display your designated Homepage
- **About** – Get summarized information about Ad Hoc
- **Help** - Get help using Ad Hoc
- **Logout** - Exit Ad Hoc

**IMPORTANT:** Unless specifically stated otherwise, use of the word ‘report’ or ‘reports’ in the description of the Ad Hoc’s functionality implies both reports and dashboards.

If more than one reporting database is available for the end user, the menu bar will also present a dropdown list to allow the user to select the database.

The Report Builder and Dashboard Builder use the currently selected database as the source for all report data. Consequently, if the currently selected database is changed, any reports that contain data from another database are not visible.

**Note:**
If the Database drop-down menu is not visible, then the user only has access to one database. Contact the system administrator if additional access is needed.
Reports Page

The Reports page is the default main page in Ad Hoc. For end users, reports are divided into Personal Reports and Shared Reports. The Personal Reports tab will display a list of reports, dashboards and folders specific to the logged in user. The Shared Reports tab will similarly display a list of the shared by all users.

Initially, the Reports page will not have any reports, dashboards, or folders to list or manage and the page will appear as:

On the page are a Personal Reports breadcrumb link to this page, the icon to display brief help for the page, and the Add button to create reports, dashboards and folders.
Once reports, dashboards or folders are added to the application, the Reports page will appear as:

In the above example is a folder named “Weekly Reports”, a report named “Customers List”, and a dashboard named “News Dashboard.

Following are the available functions:

**Add** – hover over the **Add** button to display the dropdown list to create a report, dashboard or folder

**Delete** – click on the **Delete** button to remove selected items from the list

**Copy** – click on the **Copy** button to replicate the selected items

**Move** – click on the **Move** button to move the selected items to another location

**Find Reports** – click on the **Find Reports** button to do a “contains” search of the Name column for the associated text. Click on the ✗ icon in the textbox to clear the text and refresh the list. This option is configurable and may be hidden.

**Notes:**
1. The **Find Reports** criteria will be retained for all subsequent visits to the page until it has been cleared out.
2. Depending on a user’s **Preference** settings, the Find Reports criteria may be retained after logging out or terminating a browser session.

**Select All** – click on the checkbox in the list header to select or deselect all items in the list
Sort – sort the list by clicking on the Name or Last Modified header. Clicking a second time will reverse the sort order.

Select Items – click on the checkbox within a row to select or deselect the item in the list

Run Reports and Dashboards – click on the report or dashboard link in the list to execute the item

Folder – click on the folder link in the list to navigate to a folder

✓ - this action icon indicates that only a single action can be performed on the item. Click on the icon to perform the action. Typically the single action is Modify.

➤ - this action icon indicates that there are multiple actions that may be performed on the item. Hover the mouse over the icon to display the dropdown list of actions available. The available actions are dependent upon the configuration and the item type; however, the list may include Modify, Rename, Copy, Move, Schedule, Archive and View Dependencies.

The following icons are used to signify a report's status or type:

- Ad Hoc Report
- Ad Hoc Report - Scheduled
- Subscribed Ad Hoc Report
- Ad Hoc Dashboard
- Imported or Web Studio Report*
- Scheduled Imported or Web Studio Report*
- Subscribed Imported or Web Studio Report*

* Web Studio is not available in the Java version.
Updating Your Profile

Click Profile Management to change your profile information. Profile information is divided into User Profile and Preferences and accessed by clicking on the respective tabs.

User Profile

The User Profile covers the user specific information. From this screen, a user's Username, Password, First Name, Last Name and Email Address may be changed.

To update your profile:

1. Type the new information into the User Profile fields provided.
2. If the Security Authentication method is not NT, then
   a. Click the Set Password button.
   b. Type your old password and new password twice in the fields provided.
   c. From the Password panel, click OK to apply the changes.
3. Modify other fields as desired.
4. Click Save to commit the changes.

Notes:

1. Username cannot be changed.
2. The ability to modify a user password from the User Profile screen may be disabled by the administrator.
3. The content of the Email Address field cannot be deleted if the user has
subscribed to a report.

**Hint:**
Enter an email address in order to be able to subscribe to scheduled reports.

**Setting Your Preferences**

Click **Profile Management** button and then select the **Preferences** tab to change your user preference settings.

---

**Manage Preferences**

**Homepage Type:**
- Application Page
- Report
- URL
- Pre-defined Report
- Auto
  - Report Management
    - Personal Reports
    - Shared Reports
  - Profile Management
    - User Profile
    - Preferences

**Retain search strings:**

**Retain sort preferences:**

---

**To update your preferences:**

1. Select a **Homepage Type**, then:
   a. If **Application Page**, select a webpage from the application tree. If a report area is selected (e.g., Shared Reports), then further refine your selection by:
      i. Click **Change Folder**.
      ii. Select a folder from the folder tree and then click **OK**.
   b. If **Report**, select a report by using the icon to view a list of reports and then click **OK**.
   c. If **URL**, then specify a URL address. Click **Test URL** to confirm that the URL can be viewed.
   d. If **Pre-defined Report**, select a report by using the icon to view a list of reports and then click **OK**.
2. Enabling the **Retain search strings** feature will retain your last search criteria for any page even after a logout.
3. Enabling the *Retain sort preferences* feature will retain your last choices for sorting of grids in the application.
4. Click **Save** to commit the changes and return to the Profile page.
5. **OPTIONAL:** Click **Restore Original Settings** to revert the preference settings back to the default settings.

**Note:**
If a Homepage is specified, the application will automatically display the designated Homepage immediately after logging into the application and when the Home link is selected.
The Report Builder

The Report Builder is a comprehensive and flexible interface designed to build full-featured reports.

**Note:**
The Report Builder is not designed to build or modify dashboards.

Hover the mouse over the **Add** button and select Report from the dropdown list to access the Report Builder.

Navigating the Report Builder

Following is a high level overview of the Report Builder and the various components and options. The details of each component are covered elsewhere in this document.

The core steps in the building of a report involve:

- selecting a report template
- selecting a source of the data for the report,
- selecting the display elements,
- configuring the display elements, and
- reviewing the output.

These steps will be exercised in this section just to show the navigation options.
After clicking the Add / Report option, a template selection dialog will be presented.

Six templates are included in addition to the Blank template. The Blank template is initially selected. Click on a template and then click on the OK button.
The Select or Modify Data Source dialog will be presented to allow the user to determine the data objects on which the report will be based.

The Add/Remove tab allows the user to select all of the data objects that form the basis of the report. Until data objects have been selected for the report the other tabs will be disabled. The Calculated Columns tab allows the user to create custom columns. The Statistical Columns tab may be selected to do cursory analysis of the data. The Sort tab determines the initial sort sequence of the data returned from the reporting database. The Filter tab allows the user to specify filter criteria for the data.

The list of data objects available to the user may be filtered by the Data Objects in dropdown list. These are categories of data objects.

The data objects tree identifies the data objects available to the end user. As objects are selected the tree will be refreshed to show the related data objects. The columns of a data object can be viewed by expanding the data object. Sample data for the object can be displayed by clicking on the icon.

The Information panel will display any helpful descriptions of the data object or column that the mouse is on.

The Preview Selected Data button will display a report dialog based on the data objects selected. From this dialog the selections can be confirmed and all of the dialogs dismissed.
The **OK** button saves the currently selected data objects and dismisses the dialog.

Once the data objects for the report have been selected, the full Report Builder interface is available.

Across the top of the page is the breadcrumb trail, a series of links to the pages and folders recently visited.

For example, clicking on Personal Reports link in the breadcrumb trail will display the Reports page. If changes to the report have not been saved, the following confirmation dialog will be displayed:
The tabbed function ribbon follows with File, Insert, and Settings tabs.

The File options are generally related to the report definition files. From this set of options you can create a new report, open an existing report, save the report definition, save the report definition by a new name or preview the current report.

The Insert options are related to display elements. The options presented in this ribbon are configurable by the administrator. The display elements may be added to the report by either clicking on the display element or drag-and-drop to a location in the Report Layout panel.

The Settings options allow the user to control the paging aspects of the report as well as select the stylesheet to be used to render the report.

Quick shortcuts are provided to save the current report definition and preview the report via the 

and 

icons, respectively.
On the left side of the page below the function ribbons are the *Report Layout* and *Data Source* panels.

The *Report Layout* panel displays thumbnails of the display elements in the sequence defined in the report. Display elements may be removed by clicking on the \( \times \) icon. Display elements may be added or rearranged by drag-and-drop methods. Clicking on the display element in the Report Layout panel will open the configuration page for the display element.

The *Data Source* panel displays the defined sources of data for the report. Data objects, calculated columns and statistical columns are listed. The **Modify Data Source** button will display the *Select or Modify Data Source* dialog.

Either panel may be collapsed or expanded by clicking on the \( \uparrow \) or \( \downarrow \) buttons.
Centered on the page is the tabbed *Configuration* panel. Each tab allows the end user to configure some aspect of a display element. Every display element will have at least one configuration tab associated with it.

As display elements are added to the report, the number of configuration tabs will grow. When the number of tabs exceeds the page width, the tabs become scrollable.

Clicking on the ◀ or ▶ arrows will scroll the tabs left and right.

The **Previous Step** and **Next Step** buttons will display the contents of the previous or next configuration tab in the *Configuration* panel. Hovering the mouse over the buttons will display a tooltip describing the action.
At the bottom of the page is the *Live Preview* panel that will show the report as it being developed. As changes are made to the configuration, the impact on the report can be viewed “live”.

This panel is initially collapsed. Click on the or buttons to collapse or expand the panel in the current browser window. Click on the to display the report preview in a separate browser window.

**Note:**
The *Live Preview* is refreshed with each change to the report configuration. The preview is a full rendering of the display element as it would appear in the report. Rendering the display element will impact the performance of the *Report Builder*, particularly for large volumes of data.

**Notes:**
1. When creating a report, the *Live Preview* panel will not begin displaying anything until a Data Object has been selected.
2. When exiting the *Report Builder*, the Ad Hoc will remember the state in which the *Live Preview* panel was last in, expanded or collapsed. Therefore, upon the next launching of the *Report Builder*, non-specific to any report, the Ad Hoc will display the *Live Preview* panel in the viewable state it was last in.
3. If the *Live Preview* feature is not offered in the *Report Builder*, contact the System Administrator to enable it.

**Note:**
After an extended period of inactivity, the web server will end a browser session and work may be lost. It is a good idea to save report modifications often to avoid this scenario.
The Dashboard Builder

The Dashboard Builder is an interface designed to build dashboards.

Note: The Dashboard Builder is not designed to build or modify reports.

Hover the mouse over the Add button and select Dashboard from the dropdown list to access the Dashboard Builder.

Navigating the Dashboard Builder

Following is a high level overview of the Dashboard Builder.

The core steps in the building of a dashboard involve:

- Specifying a dashboard name
- Configuring one or more dashboard panels

These steps will be exercised in this section just to show the navigation options.

Across the top of the page is the breadcrumb trail, a series of links to the pages and folders recently visited.

For example, clicking on Personal Reports link in the breadcrumb trail will display the Reports page. If changes to the dashboard have not been saved, the following confirmation dialog will be displayed:
Below the breadcrumb trail is dashboard management bar that allows the specification of the Dashboard Name, dashboard management with Save and Save As buttons, dashboard review with the Preview Dashboard button, navigation back to the Reports page with the Back to Reports List button, and general control of the dashboard configuration with the Dashboard Settings expand/collapse button.

Clicking on the  or  buttons will collapse or expand the dashboard settings panel.

Below the dashboard management bar is the list of dashboard panels. Initially only the Add button is displayed. When one or more panels have been configured, the dashboard list will appear as:

The Delete button will remove the selected panels. Panels are selected by clicking on the checkbox for the panel. All panels may be selected or deselected by clicking on the checkbox in the list header.

Actions may be performed on each panel by hovering the mouse over the icon to display the dropdown list of actions available and selecting the action. The available actions are Modify Dashboard Panel, Move Up and Move Down.
Both the **Add** button and the *Modify Dashboard Panel* action will display the *Panel Settings* dialog.

![Panel Settings dialog](image)

After entering the panel settings, click on the **Save Panel** button to temporarily save the panel definition and return to the list of panels.

The dashboard definition is permanently saved through the **Save** or **Save As** options in the *Dashboard Builder*. 
CHAPTER 2
Data Sources

Every report is based on a source of data. Data sources refers to the data objects and columns related to a reporting database as well as calculated columns and statistical columns defined for the report.

Selecting a Data Source

Generally the first step in the Report Builder is the selection of the data source. The Report Builder wizard automatically drives the user to the Select or Modify Data Source dialog as part of creating a new report. The same dialog is presented when the Modify Data Source button is clicked.

If the data objects have been categorized, a Data Object in dropdown list will be presented and acts as a filter for the list of data objects. The list of data objects may be changed by selecting a different category from the list. All data objects may be displayed by selecting the “(All)” option in the list.

To select a data object to be used in the report, click on the checkbox adjacent to the data object. Every time a data object is selected the tree of data objects is refreshed to display all of the related data objects. Continue selecting data objects and click on the OK button to save the selected items as a data source for the report.
The Exclude duplicate rows checkbox indicates that only distinct rows should be returned from the database when the report is executed. Rows having identical values for all selected columns will be excluded.

After saving the data source, the Data Source panel will reflect the selected data objects and columns.

If the data source for the report needs to be adjusted, click on the Modify Data Source button, make the required changes in the Select or Modify Data Source dialog, and click on the OK button to save the changes.

**Note:**
Modifying a data source for the report may require reconfiguration of the attributes for a display element.

**Note:**
Most reports are based on a single data source. All of the display elements share the same data source. By default Ad Hoc is configured to allow only a single data source per report; however, the administrator can configure Ad Hoc to allow the specification of multiple data sources for a report. See Chapter 14 for details on using multiple data sources in a report.

**Note:**
Calculated Columns and Statistical Columns are also data sources for a report and are reflected in the Data Source panel. Refer to Chapter 3 for details on Calculated and Statistical Columns.

**Note:**
If only one data object is selected, column references in the Report Builder will not identify the data object. If multiple data objects are selected, column references will be “Data Object.Column Name” notation.
Sorting Data

The data returned from the database may have a default sort order specified. This will determine the initial display order of the data for tabular reports and the initial population of crosstab reports. The sort order may be overridden when the report is executed if that option is enabled.

To set the initial sort order of the data, click on the Modify Data Source button to display the Select or Modify Data Objects dialog. Click on the Sort tab to display:

The sort order must be set column by column.
Click on the **Add a Column** button to create a sorting level.

<table>
<thead>
<tr>
<th>Column</th>
<th>Direction</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product/Product D</td>
<td>Ascending</td>
<td>X</td>
</tr>
</tbody>
</table>

Select a column from the *Column* dropdown list and the *Direction* (Ascending or Descending). Repeat the process for all of the columns that must be used to set the sort sequence of the data.

To remove a column from the sort sequence, click on the X for the column.

If the *Column* order in the list needs to be adjusted, use the drag-and-drop method by clicking on the ⚪ drag handle and dropping the column where necessary.

At the bottom of the *Sort* tab is the *Return First n Rows* attribute. This may be set to limit the number of rows returned from the reporting database for the report. This feature allows the report to be built on large datasets more efficiently by restricting the number of rows returned during development and testing. After the report design is complete, the value may be removed to report from the full dataset.
Setting Filters

Data used in the report may be filtered by various criteria. The criteria may be set for the report by the developer ("non-Ask" parameters) or may be supplied by the user when the report is executed ("Ask" parameters).

To set a filter for the report click on the Modify Data Source button to display the Select or Modify Data Objects dialog. Click on the Filter tab to display:

To create a filter parameter, click on the Add a Parameter button to display the Parameter Details dialog.
A parameter takes the form of an equation similar to:

\[ \text{Label is Compared to Value} \]

where \text{label} represents a column name, \text{compared to} represents a comparison operator, and \text{value} represents a threshold.

The available comparison operators are:

- Equal to
- Not equal to
- Less than
- Greater than
- Less than or equal to
- Greater than or equal to
- Starts with
- Does not start with
- Ends with
- Does not end with
- Contains
- Does not contain
- Is null
- Is not null
- Between
- Not between
- In list
- Not in list
- In cascading list

Notes:
1. These operators are only available for data of type String or Text.
2. The operators available are dependent upon the column's data type. For example, a numeric data type would not include operators such as \text{true/false}. 
To set a data parameter to a *Specific Value* or *Pre-defined Date*:

1. From the *Column* drop-down menu, select the desired column.
2. From the *Operator* drop-down menu, select the desired comparison operator.
3. From the *Value type* drop-down menu, select either *Specific Value* or *Pre-defined Date*.
4. Specify a threshold value(s) in the *Value* field. Click the 🔍 icon to view a list of valid values from the database and then populate the Value field from the value(s) selected.
5. Click **OK** to add the parameter to the report.
6. Click the ✗ icon adjacent to any parameter to delete that parameter from the report. Click the 📐 icon to modify a parameter.
7. Add more parameters by clicking the **Add a Parameter** button and repeating the steps above.

**Notes:**

1. If the *In list* or *Not in list* operator is selected, then more than one value may be specified. If manually typing in each value, then follow each entry by the [ENTER] key.
2. If the main data column is of date type, an additional choice of values called **Pre-defined Date**. Pre-defined dates are dates in the form of a token, such as Today, This Year End, Last Fiscal Quarter Start, etc. Pre-defined dates get evaluated at the time the report runs. If the pre-defined date token is evaluated to a column containing time, then no records will be returned at runtime.
3. If the value is a number, the *Value* field must contain a valid number to build the report. If the *In cascading list* or *Not in cascading list* operator is selected, then a user must choose a cascading filter and as a result do not have the option to specify a value. See the ‘Running Reports’ chapter for more information about cascading filters.
4. The *Filter* functionality does not support conditions against data types of type **Time**. Date/Time data types are supported but their time portion will be ignored.
5. Specifying a Session Parameter as a value in report parameters is permissible. There are implications related to scheduling and archiving. In addition, modification of the session parameter after the report is built may “break” the report which may “break” schedules. Subscribed users may be automatically notified when a schedule is “broken”.

**Hint:**

When adding multiple parameters, a logical operator (**And** or **Or**) becomes available for selection at the beginning of the next parameter. Use this operator to set the cumulative conditions for the parameters.
If the report contains two or more parameters, the icon appears for each additional parameter. The directional pad gives users the ability to create *levels* for each parameter. Control the order of evaluation for multiple parameters using the directional pad.
Ask Parameters

Enable the *Ask in Report* option to offer the report viewer the option of changing the threshold value before the report is rendered. Instead of limiting the report to predefined parameters, the values can be modified while browsing the report.

Marking an operator as an "ask" parameter presents a few other options in the *Parameter Details* dialog.

The parameter caption will be automatically generated if left blank.

*Control Type* values depend on both the operator picked and the selected column’s data type. For example, a text type column with *Equal To* operator presents the following choices:

- Text
- Dropdown
- List (single select)

The *In list* operator produces the following choices:

- List (multi-select)
- Text (multi line)

A date type column with *Equal To* operator produces the following choices:

- Date
- Dropdown
- List (single select)
A Boolean type column with *Equal To* operator produces the following choices:

- Checkbox
- Dropdown
- List (single select)

If more than one parameter is presented to the user, the option to display each parameter adjacent the previous one or on a new line is available. Choose by marking the desired radio button for *Display this parameter*.

**Notes:**
1. With the control type of *List (multi select)* selected, the initial display of the report will appear with the Ask parameter’s list populated with all possible values from the database and with the default values highlighted/pre-selected.
2. With the control type of *Text (multi line)* selected, the initial display of the report will appear with the Ask parameter’s list populated with only the default values. The values will not be highlighted/pre-selected.
3. With the control type of *Dropdown* selected, *Offer All Option* checkbox is made available. Checking this checkbox will set the first row of the dropdown list to “All”, allowing the report viewer to use that option as the report parameter.
4. Parameters based on comparing two columns cannot be “asked” from the user.
Advanced Concepts in Data Filtering

Advanced data filtering makes it possible to define groups of parameters that work together to filter undesirable data from the report. Users can define multiple parameters and control the order of evaluation. Filter report data to control what users see at runtime.

Data filtering gives users the ability to control the content of the report. Filter extraneous data from the report by defining one or more parameters that are evaluated at runtime. The directional pad control (↑↓) enables users to control the order of evaluation.

The individual arrows of the control perform the following functions:

- ▲ Shifts a parameter one position higher in the list (retains indentation)
- ▼ Shifts a parameter one position lower in the list (retains indentation)
- ▶ Indents a parameter one position left
- ▶ Indents a parameter one position right

As parameters are indented to the right, enclosing parentheses appear to indicate the order of evaluation.

Users can also perform a row-level comparison with fields in two different columns. In this case, the parameter takes the form of an equation similar to:

\[ \text{Label1} \text{ is Compared to Label2} \]

where label1 represents the first column name, compared to represents a comparison operator, and label2 represents the second column name.

To compare values from two different columns:

1. From the Column drop-down menu, select the desired column.
2. From the Operator drop-down menu, select the desired comparison operator.
3. From the Value type drop-down menu, select Other Data Column.
4. From the Value field drop-down menu, select the desired column the comparison will be performed against.
5. Click OK to add the parameter to the report.
6. Click the ⌫ icon adjacent to any parameter to delete that parameter from the report. Click the ☰ icon to modify a parameter.

Note:

When comparing two different columns, the Ask in Report checkbox is disabled.
Using Session Parameters

If session parameters have been defined for the Ad Hoc instance, the parameters detail dialog may be slightly different. See the following picture:

Notice that there is a Value source dropdown. The Value source is typically a “Specific Value”; however, if session parameters have been defined, “Session Parameter” may be selected as the Value source. When “Session Parameter” is selected, a dropdown list of relevant session parameters is displayed.

Session parameters are one of five types; date, number, numeric list, text or textual list. The dropdown list of session parameters will contain the session parameters that match the data type of the Column. The list is also restricted by the Operator selected.

For date Columns, the date session parameters will be shown in the list of available session parameters.

For numeric Columns, either the number or numeric list session parameters will be shown in the list of available session parameters. If the Operator is set to “In List” or “Not In List”, the numeric list session parameters will be shown, otherwise the number session parameters will be shown.

For text Columns, either the text or textual list session parameters will be shown in the list of available session parameters. If the Operator is set to “In List” or “Not In List”, the textual list session parameters will be shown, otherwise the text session parameters will be shown.
**Input Parameters**

Certain data objects, those based on a stored procedure or function, may depend upon input parameters to execute properly. If the System Administrator has determined that the input parameter values may be supplied by the end user, when the data object is selected for use filters will be automatically generated. These generated filters may be reviewed and edited on the *Filter* tab of the *Modify Data Source* dialog.

As an example:

![Filter tab of the Modify Data Source dialog](image)

This filter was automatically created when the data object requiring the input value was selected for use in the report. Notice that there is no operator specified. The logic associated with the usage of the value is contained in the stored procedure or function.
The filter may be edited by clicking on the action icon. The **Parameter Details** dialog will be shown.

The *Default Value* reflects the default value set by the System Administrator and may be overridden for the report.

By default the parameter value will be entered by the report user when the report is run. The *Ask in Report* checkbox determines whether the user is permitted to supply the value when the report is executed.

The *Caption* is displayed in the report and identifies the type of value expected by the end user when the report is run.

The *Control Type* dropdown list presents the list of controls that might be used to collect the value when the report is run.

Click on the **OK** button to store the parameter details in the report definition.
Ad Hoc gives users the ability to create custom data columns. Custom data columns can either be a calculation or a computed statistic from data in other columns. Both types of columns are considered data sources for the report and may be created through the Select or Modify Data Sources dialog.

To create either a Calculated Column or Statistical Column, click on the Modify Data Source button to display the Select or Modify Data Objects dialog. Click on either the Calculated Columns or Statistical Columns tabs.

**Calculated Columns**

*Calculated Columns* offer the ability to create new columns for the report based on a specified formula applied to data from existing columns.

In addition to the availability of data source columns, customized columns can be created that consist of calculations performed on data from other columns in the report. Calculations are performed with date, numeric and non-numeric data types. The operands of the formula are either constants or the names of existing data columns included in the report. Users can create formulas from the six provided operators, use the predefined functions or utilize any SQL function supported by the selected report database.
The goal of the calculated column process is to create and name a *Definition* that the reporting database can interpret and return data. Consequently, the *Definition* must conform to the reporting DBMS SQL syntax rules for a column.

It is not required that any of the helpful controls are used to create the *Definition*. Knowledgeable users can simply enter the definition in the text box. It is highly recommended, however, that columns are inserted into the *Definition* by clicking on the column from the data object/column tree. The column reference will be placed at the last cursor position in the *Definition* textbox.

In the upper left corner of the *Calculated Columns* tab are the most common functions that are used in the definition of a calculated column.

**Functions:**

- Date/Time
- Text
- Math

The functions are categorized according to the generic data types of columns; date, text, and numeric data. The dropdown lists may be viewed by hovering the mouse over the buttons. Click on the function to insert the reference into the *Definition* textbox. For the functions requiring additional arguments or information, a dialog will be presented to complete the function. For example, the *Text/Concatenate* function will display the following dialog:
To complete this particular dialog, click on the String1 text box and then click on a column. The column reference will be placed into the text box. Only the columns relevant to the function type will be presented for selection. Repeat the process for String2 and click on OK to post the function into the Definition text box. The other function dialogs behave similarly.

On the left side of the Calculated Columns tab of the Select or Modify Data Source dialog is the data objects/columns tree. To place the column reference into the Definition, click on the column.

After a calculated column has been defined, the data objects/columns tree will be refreshed and the calculated column added to the tree along with two management actions. Click on the icon to edit the calculated column definition. Click on the icon to remove the calculated column.

At the top of the right side of the Calculated Columns tab are operators that may be added to the Definition.

Clicking on any of the operators will place the symbol in the Definition at the last cursor position. The More dropdown list contains the AND, OR, and NOT operators that may be added to the Definition by clicking on them.

The Definition text box is the actual work area. It may be populated from the functions, columns and operators available or the user can enter the calculated column definition directly by typing in the textbox.

The Test button will verify that the calculated column definition meets the syntax rules for the reporting DBMS. If so, a mini-report displaying the calculated column and the underlying data from the reporting database will be shown.
Ad Hoc must know the data type of the resultant calculated column. In most cases the data type can be accurately determined from the data type of the underlying columns or calculation. The *Auto* option allows Ad Hoc to use the implied data type. To provide the specific data type or override the implied data type, either select the data type from the *Type* dropdown list or click on the **Determine Type** button.

Enter the *Name* of the calculated column in the provided textbox.

The **Preview Selected Data** button will display a report of all of the columns, including the defined calculated column in the *Selected Data Preview* dialog. From this report dialog, clicking on the **Select and Continue** button will save the current calculated column definition and dismiss all of the dialogs.

The **Save** button verifies the *Definition*, stores the *Name* and *Definition* temporarily, clears the *Definition* textbox and updates the data object / column tree.

The **Clear** button erases the contents of the *Definition* textbox.

The **New** button clears the contents of the *Definition* textbox and resets the Name. If the existing *Definition* has not been saved, a confirmation dialog will be shown.

The **Cancel** button will discard any changes made in the *Select or Modify Data Source* dialog and dismiss the dialog.

Click the **OK** button to save all of the changes made in the *Select or Modify Data Source* dialog. The newly defined calculated columns are then available for selection in the Report Builder.

**Note:**

A calculated column must be used in the report for the column to be saved in the report definition. Unused calculated columns are automatically removed from the report definition.
**Statistical Columns**

*Statistical Columns* give users the ability to create new columns for the report based on a particular statistic from data in other columns. The following statistical column types are supported with the application:

- Rank
- Reverse Rank
- Percentile
- Running Total
- Difference from Previous

**To create a statistical column:**

1. Click on the **Modify Data Source** button to show the *Select or Modify Data Source* dialog
2. Click on the **Statistical Columns** tab
3. Choose a function from the **Function Type** drop-down menu.
4. Select a column from the *Columns* list - the function is applied to the column's value.
5. **OPTIONAL:** Modify the default **Name** in the field provided.
6. Click **OK** to make the newly created statistical column available for selection in the Report Builder.
Notes:
1. When the OK button is clicked the column’s name is validated for SQL syntax accuracy. If the name is invalid, then a message will appear.
2. If a statistical column is not used in the report, then it shall be deleted when exiting the Report Builder. Basically, use it or lose it.

The *Rank* function ranks data from the lowest value to the highest value. For example, a total of $15.00 would receive a higher rank than a total of $25.00. When one or more data rows have equal values, the rank value is the same for each row. In the following figure, the first five orders listed all have a rank of 1. Since five orders share a rank of 1, the next available rank value is 6.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>OrderID</th>
<th>UnitPrice</th>
<th>Quantity</th>
<th>Freight</th>
<th>Quantity - Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Königlich Essen</td>
<td>10323</td>
<td>$14.40</td>
<td>4</td>
<td>$4.88</td>
<td>1</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10325</td>
<td>$10.00</td>
<td>4</td>
<td>$64.86</td>
<td>1</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10323</td>
<td>$11.20</td>
<td>4</td>
<td>$4.88</td>
<td>1</td>
</tr>
<tr>
<td>Die Wandernde Kuh</td>
<td>10312</td>
<td>$36.40</td>
<td>4</td>
<td>$40.26</td>
<td>1</td>
</tr>
<tr>
<td>Lehmanns Marktstand</td>
<td>10343</td>
<td>$10.00</td>
<td>4</td>
<td>$110.37</td>
<td>1</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10323</td>
<td>$12.40</td>
<td>5</td>
<td>$4.88</td>
<td>6</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10325</td>
<td>$20.00</td>
<td>6</td>
<td>$64.86</td>
<td>7</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10345</td>
<td>$11.20</td>
<td>9</td>
<td>$249.06</td>
<td>8</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10325</td>
<td>$18.60</td>
<td>9</td>
<td>$64.86</td>
<td>8</td>
</tr>
</tbody>
</table>

The *Quantity - Rank* column ranks the Quantity column’s value from lowest to highest.

Note: *Rank* values are never higher than the actual number of rows in the report.
The Reverse Rank function classifies data from the highest value to the lowest value; a larger value receives a higher rank. For example, a total of $25.00 would receive a higher rank than a total of $15.00. When one or more data rows have equal values, the rank value is the same for each row. In the following figure, the eighth order and subsequent four orders listed all have a rank of 8. Since five orders share a rank of 8, the next available rank value is 13.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Order ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Freight</th>
<th>Quantity - Reverse Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>QUICK-Stop</td>
<td>10345</td>
<td>$7.30</td>
<td>80</td>
<td>$249.06</td>
<td>1</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10345</td>
<td>$32.00</td>
<td>70</td>
<td>$249.06</td>
<td>2</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10396</td>
<td>$17.20</td>
<td>60</td>
<td>$135.35</td>
<td>3</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10342</td>
<td>$10.00</td>
<td>56</td>
<td>$54.83</td>
<td>4</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10361</td>
<td>$27.20</td>
<td>55</td>
<td>$183.17</td>
<td>5</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10361</td>
<td>$14.40</td>
<td>54</td>
<td>$183.17</td>
<td>6</td>
</tr>
<tr>
<td>Lehmanns Marktstand</td>
<td>10343</td>
<td>$26.60</td>
<td>50</td>
<td>$110.37</td>
<td>7</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10342</td>
<td>$15.20</td>
<td>40</td>
<td>$54.83</td>
<td>8</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10325</td>
<td>$27.80</td>
<td>40</td>
<td>$64.06</td>
<td>8</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10342</td>
<td>$19.20</td>
<td>40</td>
<td>$54.83</td>
<td>8</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10337</td>
<td>$7.20</td>
<td>40</td>
<td>$108.26</td>
<td>8</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>10396</td>
<td>$7.20</td>
<td>40</td>
<td>$135.35</td>
<td>8</td>
</tr>
<tr>
<td>Die Wundernde Kuh</td>
<td>10356</td>
<td>$10.00</td>
<td>30</td>
<td>$36.71</td>
<td>13</td>
</tr>
</tbody>
</table>

The Quantity - Reverse Rank column ranks data in the Quantity column from highest to lowest.

The Percentile function classifies data based on a percentage of the value distribution. In the following figure, a value equal to or greater than 70 but less than 100 is reported as the 98th percentile.

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>Order ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Freight</th>
<th>Quantity Percentile</th>
</tr>
</thead>
<tbody>
<tr>
<td>Severe-lot Markets</td>
<td>10452</td>
<td>$15.50</td>
<td>100</td>
<td>$140.00</td>
<td>100.00%</td>
</tr>
<tr>
<td>Ernst Handel</td>
<td>10430</td>
<td>$14.00</td>
<td>70</td>
<td>$459.00</td>
<td>95.93%</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10418</td>
<td>$15.20</td>
<td>60</td>
<td>$18.00</td>
<td>96.30%</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>10418</td>
<td>$7.60</td>
<td>55</td>
<td>$18.00</td>
<td>94.04%</td>
</tr>
<tr>
<td>Ernst Handel</td>
<td>10450</td>
<td>$8.00</td>
<td>50</td>
<td>$459.00</td>
<td>92.72%</td>
</tr>
<tr>
<td>Ernst Handel</td>
<td>10450</td>
<td>$31.20</td>
<td>45</td>
<td>$459.00</td>
<td>90.00%</td>
</tr>
<tr>
<td>Queen Cezinha</td>
<td>10406</td>
<td>$36.40</td>
<td>42</td>
<td>$108.00</td>
<td>86.89%</td>
</tr>
<tr>
<td>Toms Spezialität</td>
<td>10249</td>
<td>$42.40</td>
<td>40</td>
<td>$12.00</td>
<td>86.00%</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>10457</td>
<td>$44.00</td>
<td>36</td>
<td>$12.00</td>
<td>84.00%</td>
</tr>
<tr>
<td>Folies gourmandes</td>
<td>10408</td>
<td>$39.40</td>
<td>35</td>
<td>$11.00</td>
<td>82.09%</td>
</tr>
<tr>
<td>Queen Cezinha</td>
<td>10406</td>
<td>$8.00</td>
<td>30</td>
<td>$108.00</td>
<td>76.00%</td>
</tr>
<tr>
<td>Que Delicia</td>
<td>10421</td>
<td>$24.90</td>
<td>30</td>
<td>$95.00</td>
<td>75.00%</td>
</tr>
<tr>
<td>Ernst Handel</td>
<td>10450</td>
<td>$30.40</td>
<td>30</td>
<td>$459.00</td>
<td>75.00%</td>
</tr>
<tr>
<td>Folk och fMHE</td>
<td>10460</td>
<td>$10.00</td>
<td>21</td>
<td>$16.00</td>
<td>74.00%</td>
</tr>
<tr>
<td>Virtuelles en stock</td>
<td>10251</td>
<td>$16.80</td>
<td>20</td>
<td>$41.00</td>
<td>62.00%</td>
</tr>
</tbody>
</table>

The Quantity Percentile column ranks data in the Quantity column based on a percentage of the value distribution.
The **Running Total** function maintains a current total of values provided in the specified column as illustrated in the following figure.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Product Name</th>
<th>Order ID</th>
<th>Order Date</th>
<th>Total Cost</th>
<th>Freight</th>
<th>Freight - Running Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Die Wandermde Kuh</td>
<td>Boston Crab Meat</td>
<td>10301</td>
<td>9/9/1996</td>
<td>$147.00</td>
<td>$45.08</td>
<td>$45.08</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>Camembert Pierrot</td>
<td>10361</td>
<td>11/22/1996</td>
<td>$1,495.00</td>
<td>$185.17</td>
<td>$228.25</td>
</tr>
<tr>
<td>Die Wandermde Kuh</td>
<td>Chai</td>
<td>10349</td>
<td>11/7/1995</td>
<td>$216.00</td>
<td>$0.76</td>
<td>$229.03</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>Chang</td>
<td>10342</td>
<td>10/30/1996</td>
<td>$364.80</td>
<td>$54.83</td>
<td>$319.97</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>Chartreuse verte</td>
<td>10323</td>
<td>10/7/1995</td>
<td>$57.60</td>
<td>$4.86</td>
<td>$62.46</td>
</tr>
<tr>
<td>QUICK-Stop</td>
<td>Chartreuse verte</td>
<td>10361</td>
<td>11/22/1996</td>
<td>$777.60</td>
<td>$233.17</td>
<td>$544.43</td>
</tr>
<tr>
<td>Frankenversand</td>
<td>Fleischwurst</td>
<td>10395</td>
<td>12/27/1996</td>
<td>$1,032.00</td>
<td>$135.35</td>
<td>$896.65</td>
</tr>
<tr>
<td>Königlich Essen</td>
<td>Genen Shouyu</td>
<td>10323</td>
<td>10/7/1996</td>
<td>$62.00</td>
<td>$4.86</td>
<td>$66.86</td>
</tr>
<tr>
<td>Die Wandermde Kuh</td>
<td>Gnocchi di nonne Alice</td>
<td>10301</td>
<td>9/9/1996</td>
<td>$600.00</td>
<td>$45.00</td>
<td>$655.00</td>
</tr>
<tr>
<td>Die Wandermde Kuh</td>
<td>Gorgonzola Teino</td>
<td>10355</td>
<td>12/18/1996</td>
<td>$300.00</td>
<td>$36.71</td>
<td>$336.71</td>
</tr>
</tbody>
</table>

Example use of Running Total based on the Freight column

The **Difference from Previous** function displays the difference from the current value and the previous value of a specified column. In the following figure, a difference of 31 is reported from rows one to two indicating a gain. A difference of -34 is reported from rows two to three indicating a loss.

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>Order ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Freight</th>
<th>Freight - Running Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toms Spezialitäten</td>
<td>10249</td>
<td>$18.50</td>
<td>9</td>
<td>$12.00</td>
<td>0</td>
</tr>
<tr>
<td>Toms Spezialitäten</td>
<td>10249</td>
<td>$42.40</td>
<td>40</td>
<td>$12.00</td>
<td>31</td>
</tr>
<tr>
<td>Virtuailles en stock</td>
<td>10251</td>
<td>$16.50</td>
<td>6</td>
<td>$41.00</td>
<td>-34</td>
</tr>
<tr>
<td>Virtuailles en stock</td>
<td>10251</td>
<td>$15.60</td>
<td>15</td>
<td>$41.00</td>
<td>9</td>
</tr>
<tr>
<td>Virtuailles en stock</td>
<td>10251</td>
<td>$16.80</td>
<td>20</td>
<td>$41.00</td>
<td>5</td>
</tr>
<tr>
<td>Queen Cozinha</td>
<td>10406</td>
<td>$14.40</td>
<td>10</td>
<td>$100.00</td>
<td>-10</td>
</tr>
<tr>
<td>Queen Cozinha</td>
<td>10406</td>
<td>$8.00</td>
<td>30</td>
<td>$100.00</td>
<td>20</td>
</tr>
<tr>
<td>Queen Cozinha</td>
<td>10406</td>
<td>$56.40</td>
<td>42</td>
<td>$100.00</td>
<td>12</td>
</tr>
<tr>
<td>Queen Cozinha</td>
<td>10406</td>
<td>$15.20</td>
<td>5</td>
<td>$100.00</td>
<td>-37</td>
</tr>
<tr>
<td>Queen Cozinha</td>
<td>10406</td>
<td>$14.70</td>
<td>2</td>
<td>$100.00</td>
<td>-3</td>
</tr>
<tr>
<td>Folies gourmendes</td>
<td>10408</td>
<td>$20.00</td>
<td>10</td>
<td>$11.00</td>
<td>0</td>
</tr>
<tr>
<td>Folies gourmendes</td>
<td>10408</td>
<td>$5.90</td>
<td>6</td>
<td>$11.00</td>
<td>-4</td>
</tr>
<tr>
<td>Folies gourmendes</td>
<td>10408</td>
<td>$39.40</td>
<td>35</td>
<td>$11.00</td>
<td>29</td>
</tr>
<tr>
<td>Oceano Atlântico Ltd.</td>
<td>10405</td>
<td>$18.60</td>
<td>12</td>
<td>$30.00</td>
<td>-23</td>
</tr>
<tr>
<td>Oceano Atlântico Ltd.</td>
<td>10405</td>
<td>$8.00</td>
<td>12</td>
<td>$30.00</td>
<td>0</td>
</tr>
</tbody>
</table>

The **Quantity Difference** column maintains the difference from the current value and the previous value of the **Quantity** column.
A table (also referred to as a “display table” to avoid confusion) presents data in a tabular style report. A column is created for every data column that is included in the report, and a row is created for every value in that data column. The Report Builder provides a table wizard to customize the table’s select columns, appearance, group data and configure paging options.

Four tabs are presented in the Report Builder for each display table; Table Columns, Column Configuration, Grouping, and Table Settings.

The Table Columns tab allows the user to determine which columns are included in the final report.

The Column Configuration tab allows the user to determine the display characteristics for each column and define column aggregations.

The Grouping tab allows the user to defined data grouping levels, the display style (flat or drill), and group level aggregations.

The Table Settings tab allows the user to configure the display table presentation characteristics such as a title, rows per page and the location of summary information.
Configuring Table Columns

The first step of the table wizard is to select the columns to be used in the display table.

To select columns for the table:

1. Click on the Table Columns tab.

2. Select one or more Available Columns and then click › to add the column(s) to the Assigned Columns list-box. Hold the CTRL key down to select multiple columns.

3. From the Assigned Columns list-box, change a column’s initial display order by clicking on either the ▲ or ▼ icon to move the row up or down. Hold the CTRL key down to select multiple columns.

4. If a column(s) in the Assigned Columns list-box is not desired, select one or more Assigned Columns and then click ◀ to remove the column(s) from the Assigned Columns list-box. Hold the CTRL key down to select multiple columns.

5. When done assigning and arranging columns, either click the Next Step button or the Column Configuration tab to begin formatting the appearance of each column.

Notes:
1. At least one data column should be selected before continuing.
2. A column description will only be available if one has been specified by the System Administrator.
To configure and delete columns in the table:

After having added columns, a column's order of appearance, display characteristics and summary information may be defined on the Column Configuration tab.

Initially only the Column, Header and Sortable columns are shown in the configuration grid. By clicking on the Show All Attributes icon, the grid is expanded as shown above. The grid may be collapsed by clicking on the Show Minimum Attributes icon.

Columns may be selected (or deselected) by clicking on the checkbox adjacent to the column. All columns may be selected or deselected by clicking on the checkbox in the upper left corner of the grid. Some of the following functions apply to the selected columns.

Columns may be rearranged by drag-and-drop methods using the handle on the left of the grid. Mousedown on the drag handle, move the row to the target location and release the mouse. Columns may also be rearranged by selecting the row and then click either the or icon to move the row up or down. To move a group of columns, select the desired columns by enabling their respective checkboxes and then click either the or icon to move the rows up or down.

Columns may be removed from the display table by selecting the column(s) and clicking the icon.
There are 9 configurable options available in Column Configuration:

- Header
- Linkable
- Sortable
- Summary
- Format
- Visualization
- Width
- Alignment
- Style

The *Header* determines the column header displayed when the report is rendered.

The *Linkable* option toggles predefined hyperlinks for records in the column. Each record in the *Linkable* column contains a hyperlink to an address specified by the System Administrator. Make column records linkable from the report by placing a check in the corresponding *Linkable* checkbox.

**Note**
The *Linkable* column will only be shown if the System Administrator has configured at least one of the columns as “hyperlink capable”.

The *Sortable* option determines whether the column in the rendered report may be sorted by the end user. The *Sortable* checkbox determines the column’s sort capability. Sort capability may be enabled or disabled for all columns by clicking on the checkbox in the header of the *Sortable* column.

The *Summary* option offers the ability to create table footers containing aggregates of values for each column of data. An unlimited number of aggregates can be created for each table column. The following aggregate functions are supported:

- Sum
- Average
- Standard Deviation
- Count
- Count Distinct
- Maximum
- Minimum
- Calculation
To manage summary values:

1. Click ☐️ to add a summary value for a specific column.

2. Click the **Add an Aggregate** button on the *Aggregates* dialog.
3. Type a name used as the internal value for the aggregate in the *Name* field.
4. Type a displayed name for the new value in the *Label* field.
5. Choose an *Aggregate* function from the drop-down menu.
6. Choose a *Format* from the drop-down menu.
7. **OPTIONAL:** If more than one aggregate has been specified, click the ▲ or ▼ icon to arrange the order in which the aggregate will appear in the column. Aggregates may also be rearranged by drag-and-drop methods using the ★ handle on the left of the grid. Mousedown on the drag handle, move the row to the target location and release the mouse.
8. Continue adding additional aggregates or click **OK** to add the summary value(s) and return to the *Column Configuration* interface.
9. Aggregates may be removed by selecting the aggregate and clicking the ✗ icon

**Note**
The ☐️ icon indicates that a summary value exists for that particular column.
One of the aggregation options is “Calculation”. This option allows the user to create a new aggregation from previously defined summary information. When “calculation” is selected, the following dialog is displayed:

The “AvgPrice” and “SumQTY” aggregates have been used in the calculation of the “AveLineItem” in this example. These two summaries were simple aggregations on the Unit Price and Quantity column.

In the Modify Calculation dialog, any of the previously defined summaries may be used in the calculation as well as aggregate functions on columns and direct constants in the definition. The default internal name for an aggregation is AGGRn, where “n” is a unique number.
The *Format* option provides data formatting options for values in each column. The following formatting options are supported:

- (none)
- General Number
- Currency
- Integer
- Fixed
- Standard
- Percent
- Scientific
- 2 or 3-digit place holder
- General Date
- Long/Medium/Short Date
- Long/Medium/Short Time
- Yes/No
- True/False
- On/Off
- HTML²
- Preserve line feed³

**Notes:**
1. *The application chooses the default Format type for each column. Changing the format type may yield undesirable results.*
2. *The Format of "HTML" may only be specified by the System Administrator and may not be changed to something different from the Column Configuration panel.*
3. *The Format of 'Preserve line feed' allows text in a memo type field to display as it is stored with line feeds (a.k.a., carriage returns) observed.*
4. *If a Format is needed that is not offered, contact your System Administrator.*
5. *Additional formats may be provided by the System Administrator*
The Visualization option allows numeric fields to be displayed with a colored indicator. The following indicators are available:

- (none)
- Bar
- Color Slider (background)
- Color Slider (circle)
- Color Slider (square)

Color indicators allow the user to define their own threshold for comparing a value at a particular row with all other values in that column. When enabling visualization on a particular column, a color slider appears in the column header for setting the threshold. The color spectrum is determined by how much the data values in the column deviate from the specified threshold. Choose to visualize each cell value as a colored shape - bar, circle or square - or shade the entire cell background. Additionally, the numeric data value can be displayed adjacent to the visualization. Following is an example of visualization.

To add a visualization affect:

1. Click to add a visualization affect for a specific column. The Visualization Options dialog will be displayed.
2. Choose a style from the Visualization Style drop-down menu.
3. Change the Show Data Values option as desired. Default setting is Yes.
4. Choose an aggregate function from the drop-down menu.
5. Click **OK** to add the summary value and return to the Column Configuration interface.

**Note:**
*The icon indicates that a visualization exists for that particular column.*

**To modify or remove a visualization effect:**

1. Click the icon associated to the column with an existing visualization.
2. From the **Visualization Options** dialog,
   a. If modifying a visualization affect, modify the settings as desired.
   b. If removing a visualization affect, select "(none)" as a Style.
3. Click **OK** to save the modifications and return to the **Column Configuration** interface.
The **Width** option offers the ability to customize the width of each column, thereby improve the appearance of the report when it is rendered in the webpage and when exported (e.g., Word, PDF). By default, a column’s **Width** value is left blank to allow the application the option to automatically determine the appropriate width based on:

- All columns in the report
- The context in each column
- The available webpage space
- The page size and orientation

When customizing a column’s width, it is important to determine the scale by which an entered value will be measured. The scale of measured can be either **pixels** or **percent** where:

- **Pixel** is a single point of picture data displayed on the monitor. Hundreds of pixels can be used to display a very small image.
- **Percentage** is a fraction of the screen space allocated for each column.

**To modify a column’s width:**

1. **OPTIONAL**: Determine the scale type to use for the entire tabular report. To toggle the scale of a column, click on the label to the right on the width field where **px** equates to pixel and **%** equates to percentage.
2. **Input** or modify the column’s **Width** value.

**Notes:**

1. **When specifying a tabular report’s column’s widths in pixels**, keep in mind the average monitor resolution settings of the end-users viewing the report.
2. **When specifying a tabular report’s column’s widths in percentages**, keep in mind that:
   a. The sum total of the percentage values must not exceed 100%.
   b. The application will use whatever percentage has not been allocated to columns for the columns without a value.
The Alignment option adjusts the position of values in columns. In the following figure, numerical values are now centered in the Quantity column.

<table>
<thead>
<tr>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>42</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>25</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>11</td>
</tr>
<tr>
<td>24</td>
</tr>
</tbody>
</table>

The Style option offers the ability to apply conditional formatting to a column’s cell based on a specific value or another column’s value. Users must create the condition and specify the formatting style. When more than one condition is specified, the application will apply the style associated to the first condition that is satisfied. Conditions are evaluated when the report is run.

Users can optionally apply the specified conditional formatting to all data columns by checking the appropriate checkbox.

<table>
<thead>
<tr>
<th>Order ID</th>
<th>Order Date</th>
<th>Product Name</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>10246</td>
<td>7/4/1996 12:00:00 AM</td>
<td>Queso Cabrales</td>
<td>12</td>
<td>$14.00</td>
<td>$168.00</td>
</tr>
<tr>
<td>10248</td>
<td>7/4/1996 12:00:00 AM</td>
<td>Singaporean Hokkien Fried Nee</td>
<td>10</td>
<td>$9.80</td>
<td>$98.00</td>
</tr>
<tr>
<td>10248</td>
<td>7/4/1996 12:00:00 AM</td>
<td>Mozzarella di Giovanni</td>
<td>5</td>
<td>$34.80</td>
<td>$174.00</td>
</tr>
<tr>
<td>10249</td>
<td>7/4/1996 12:00:00 AM</td>
<td>Tofu</td>
<td>9</td>
<td>$18.60</td>
<td>$167.40</td>
</tr>
<tr>
<td>10249</td>
<td>7/4/1996 12:00:00 AM</td>
<td>Manjinup Dried Apples</td>
<td>40</td>
<td>$42.40</td>
<td>$1,696.00</td>
</tr>
<tr>
<td>10250</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Jack’s New England Clen Chowder</td>
<td>10</td>
<td>$7.70</td>
<td>$77.00</td>
</tr>
<tr>
<td>10250</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Manjinup Dried Apples</td>
<td>35</td>
<td>$42.40</td>
<td>$1,484.00</td>
</tr>
<tr>
<td>10250</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Louisiana Fiery Hot Pepper Sauce</td>
<td>15</td>
<td>$16.00</td>
<td>$240.00</td>
</tr>
<tr>
<td>10251</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Gustaf’s Knäckebröd</td>
<td>6</td>
<td>$16.00</td>
<td>$96.00</td>
</tr>
<tr>
<td>10251</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Ravoli Angelo</td>
<td>15</td>
<td>$15.60</td>
<td>$234.00</td>
</tr>
<tr>
<td>10251</td>
<td>7/8/1996 12:00:00 AM</td>
<td>Louisiana Fiery Hot Pepper Sauce</td>
<td>20</td>
<td>$16.80</td>
<td>$336.00</td>
</tr>
<tr>
<td>10252</td>
<td>7/5/1996 12:00:00 AM</td>
<td>Sir Rodney’s Marmalade</td>
<td>40</td>
<td>$64.80</td>
<td>$2,592.00</td>
</tr>
<tr>
<td>10252</td>
<td>7/5/1996 12:00:00 AM</td>
<td>Geistost</td>
<td>25</td>
<td>$2.00</td>
<td>$50.00</td>
</tr>
<tr>
<td>10252</td>
<td>7/5/1996 12:00:00 AM</td>
<td>Camembert Fierrot</td>
<td>40</td>
<td>$27.20</td>
<td>$1,088.00</td>
</tr>
<tr>
<td>10253</td>
<td>7/10/1996 12:00:00 AM</td>
<td>Gorgonzola Tolino</td>
<td>20</td>
<td>$10.00</td>
<td>$200.00</td>
</tr>
</tbody>
</table>

A conditional style takes the form of an equation similar to:

\[
\text{Label is Compared to Value} \\
\text{or} \\
\text{Label is Compared to Column}
\]

where Label represents a column name, Compared to represents a comparison operator, Value represents a threshold, and Column represents another data column.
The available comparison operators are:

- Equal to
- Not equal to
- Less than
- Greater than
- Less than or equal to
- Greater than or equal to
- Starts with
- Does not start with
- Ends with
- Does not end with
- Contains
- Does not contain
- Between
- Not between

Notes:
1. These operators are only available for data type of type String or Text.
2. The operators available are dependent upon the column's data type.

To add a conditional Style:

1. Click or to access the Condition Styles dialog. In the figure below two styles have been added and the Add a Condition panel opened to show the various options in the dialog.

2. Click the Add a Condition button. In the panel are the Column, Operator, Value and Style attributes.
3. Choose a Column from the drop-down menu to base the conditional styling on.
4. Choose a comparison Operator from the drop-down menu.
5. From the Value type drop-down menu, choose either Specific Value, Pre-defined Date, or Other Data Column.

6. Specify a threshold Value. If a Value type of:
   a. Specific Value was selected, then type in a value or click the icon to view and select a valid value from the database.
   b. Pre-defined Date was selected, select a token (i.e., Today).
   c. Other Data Column was selected, select a column from the dropdown list.

7. Choose a Style from the dropdown list.

8. Click OK to add the styling condition.

9. Add more parameters by clicking Add a Condition and repeating the steps above.

10. **OPTIONAL**: As styles are applied based on the first condition that is satisfied, move a condition up or down in the list by clicking the ▲ or ▼ icon respectively.

11. **OPTIONAL**: Enable Add this style to all columns to apply the Style to all columns of a row in the table.

12. Click OK to save the styling condition(s) and return to the Column Configuration interface.

**Notes:**
1. Pre-defined dates get evaluated at the time the report runs.
2. If the value is a number, the value field must contain a valid number to complete the comparison.
3. The icon indicates that at least one conditional style exists for that particular column.

To modify or remove a conditional Style:

1. Click the icon to access the Style Details panel for a specific column.

2. From the Style Details panel:
   a. If modifying a Style, click the icon associated to a specific Style's condition. Modify the conditions as desired and then click OK to save the condition.
   b. If removing a Style, click the icon associated to a specific Style's condition.
   c. **OPTIONAL**: Enable/Disable Add this style to all columns to apply/remove the Style to/from all columns in the table.

3. Click OK to save the modifications and return to the Column Configuration interface.
Adding a new custom column to the data table

From the Column Configuration page, a new column may be added to the data table by clicking on the Add Custom Column button. Columns created in this manner may reference previously defined summary information.

In the example below, a percentage column (Pct Qty) has been created using the Quantity column and the SumQty summary.

The sequence of events for this example was:

1. Click on the Add Calculated Column button on the Column Configuration page
2. Click on the Quantity column from the Order Details data object
3. Click on the division symbol from the list of operators
4. Click on the SumQty summary from the Available Summaries (previously created as a simple column summary and named SumQty)
5. Click on the multiplication symbol from the list of operators
6. Type 100.0 in the Definition text area
7. Type Pct Qty in the Name text box
8. Click on the OK button to save the result

Note: This type of calculated column may use reporting summary information in the calculated column definition.
Note: If a data table contains a calculated column, the configuration grid will display an Actions column. Clicking on the icon allows the column to be edited.
Grouping Data

Ad Hoc provides two styles of grouped reports - *Flat-Table* and *Drill-Down*. The grouped flat-table style organizes records into groups and hides duplicate entries to make the grouped report more presentable. Use the flat-table style to give other users the ability to export the complete report to different formats such as PDF and Excel. The grouped drill-down style organizes records into groups and any remaining columns are included in a sub-report. Use the drill-down style to give other users the ability to hide and show sub-reports.

The feasibility of grouping data highly depends on the data source chosen for the report. A grouped report is not necessarily appropriate when the data is simply a list of customers. If the data source contains information about customers and orders, a grouped report will definitely improve the presentation of the report. The application provides two ways to group data for flat-table and drill-down style reports - *multiple grouping columns* and *multiple layers*. Users can combine both methods when creating grouped reports.

**Multiple Grouping Layers**

Creating grouped reports with multiple layers is useful in scenarios where the report requires more than one grouping to organize all the data.

For example, all the customers can be grouped together, and then group by the shipping company and then group by the order date. This scenario is illustrated as a grouped flat-table report and as a grouped drill-down report in the following figures.

![A grouped flat-table report with three layers.](image-url)
A grouped drill-down report with three grouping layers.

**Multi-Column Grouping**

Multi-column grouping is useful for displaying more information on a single grouping layer. For example, users can group by customer and then by shipping company, showing both the customer and shipping company on the same layer.

Multiple grouping columns work well with flat-table style reports, since duplicate entries are removed from the final report.
Grouped Flat-Table

The grouping flat-table report style is useful for displaying the entire report in an organized, presentable way.

In the following figure, the *Customer Name* column is the grouping column and any row that contains a group is highlighted. All associated rows for a specific group are displayed beneath the grouping row. Aggregated values for each group are computed and displayed in a separate row.

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>OrderID</th>
<th>Order Date</th>
<th>Product Name</th>
<th>Unit Price</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alfredo Futterkiste</td>
<td>10643</td>
<td>8/25/1997</td>
<td>Rübsa Sauerkraut</td>
<td>$45.00</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>10643</td>
<td>8/25/1997</td>
<td>Chantreuses Verte</td>
<td>$10.00</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>10643</td>
<td>8/25/1997</td>
<td>Speckwurst</td>
<td>$12.00</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>10692</td>
<td>10/3/1997</td>
<td>Veggie-spread</td>
<td>$43.90</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>10702</td>
<td>10/13/1997</td>
<td>Aniseed Syrup</td>
<td>$10.00</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>10702</td>
<td>10/13/1997</td>
<td>Lakkalodóri</td>
<td>$18.00</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>10835</td>
<td>1/15/1998</td>
<td>Raclette Courdavault</td>
<td>$55.00</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>10835</td>
<td>1/15/1998</td>
<td>Original Frankfurter Grün Salz</td>
<td>$13.00</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>10952</td>
<td>3/16/1998</td>
<td>Grandma’s Boysenberry Spread</td>
<td>$25.00</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>10952</td>
<td>3/16/1998</td>
<td>Rübsa Sauerkraut</td>
<td>$45.00</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>11011</td>
<td>4/9/1998</td>
<td>Escargots de Bourgogne</td>
<td>$13.25</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Max Unit Price:</strong> $55.00</td>
<td><strong>Avg Quantity:</strong> 15</td>
<td></td>
</tr>
</tbody>
</table>

A grouped flat-table report of customer invoices.
Grouped Drill-Down

The grouped drill-down report offers viewers the ability to control the appearance of the report by hiding and showing sub-reports for each record in the *grouping column*.

In the following figure, the *Customer Name* column is the grouping column (always the first column of the main report) and all other columns appear in the sub-report. Users can show/hide sub-reports for each group of records by clicking the hyperlink provided in the *Details* column. Any additional columns included in the main report are aggregations of a particular column from the sub-report.

![Drill-down report example](image)

A drill-down style report of customer invoices.

**Note:**
Users can disable drill-down functionality for the *Details* column or hide the column completely.
Grouping Layers

Creating and configuring a grouping layer:

1. **PREREQUISITE**: If grouping aggregates are to be defined, then the column(s) to be aggregated must first be added to the report in the *Table Columns* tab.
2. Click on the *Grouping* tab.

![Grouping tab with Grouped Flat-Table style selected.](image)

*Note*: The Roll up last layer option is presented for the flat grouping. This allows the user to create “summary” flat grouped reports where the non-aggregated information is hidden from view. The data details that are normally shown in the last grouping layer are excluded from the report.

3. Choose a grouping style (e.g., Flat-Table, Drill-Down) and then click **Add Grouping Layer** to display the *Grouping Columns* dialog.
4. Select a column(s) from the *Available Columns* list-box and then click ▶ to move the column(s) to the *Grouped Columns* list-box. Hold the CTRL key down to select multiple columns.

5. **OPTIONAL**: If a column(s) in the *Grouped Columns* list-box¹ is not desired, select the column(s) in the *Grouped Columns* list-box and then click ◀ to move the column(s) back to *Available Columns* list-box. Hold the CTRL key down to select multiple columns.

6. **OPTIONAL**: To move a column in the *Grouped Columns* list-box² up or down, select the column(s) and click the ▲ or ▼ icon respectively.

7. **OPTIONAL**: If using the flat-table grouping style, enable the 'Insert a page break between groups of PDF Export' option³.

8. **OPTIONAL**: Click **OK** to retain the modification and exit the panel or continue configuring the other features on the grouping layer.

**Notes:**

1. The *Grouping Layer* dialog keeps track of the grouped columns used.
2. The order in which the columns appear in the *Grouped Columns* list-box dictates the order in which the columns will appear in the report. This display order over-rides that which is specified in the *Column Configuration* tab.
3. This feature is only offered on the first layer of a grouped flat-table. If the Export to PDF feature is not used in the report, then enabling this feature will not have any effect on the report.
After having added columns to display in the tabular report and after having selected a column(s) to group the layer on, group aggregates can be created.

To create a grouping layer aggregate:

1. From the Grouping Layer dialog, click the **Add an Aggregate Column** button. If the button is not visible, click on the **Show All Attributes** icon at the top of the dialog.

2. Choose a **Column** from the drop-down menu.
3. Choose an **Aggregate function** from the drop-down menu.
4. **OPTIONAL**: If using the grouped flat-table style, type a descriptive name for the aggregate value in the **Label** field.
5. **OPTIONAL**: If using the grouped drill-down style:
   a. Type a descriptive name for the aggregate column in the **Header** field.
   b. To include the column in the sub-report, enable the **Include in sub-report** option.
6. **OPTIONAL**: If more than one aggregate has been specified in the grouping layer, click the ↑ or ↓ icon to arrange the order in which the aggregate will appear in the grouping column.
7. **OPTIONAL**: Click **X** to remove a grouping aggregate.

8. **OPTIONAL**: Click **OK** to retain the modification and exit the panel or continue configuring the other features on the grouping layer.

**Notes:**

1. For numeric values, choose aggregations like Sum, Average, Standard Deviation, Count, Count Distinct, Minimum, or Maximum.

2. For text values, Sum and Average are excluded from the list of aggregate functions. Choosing Minimum selects the first alphabetized entry and Maximum selects the last.

3. For date values, Maximum chooses the latest date and Minimum chooses the earliest.
Group aggregates in a flat-table report.

Group aggregates in a drill-down report.
When using the grouped drill-down style, the Grouping Layer dialog presents different options.

The Summary Column Options are described in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>No summary</td>
<td>The report is rendered without a Details column and no means to drill-down to the sub-report.</td>
</tr>
<tr>
<td>Auto-generated column (drill-down enabled)</td>
<td>The report is rendered with a Details column displaying a hyperlink with the count of the number of detail records contained in the sub-report. The hyperlink allows the user the ability to drill-down to the sub-report. This is the default option.</td>
</tr>
</tbody>
</table>
When one of the auto-generated column display options is selected, the following options may be applied to the summary column:

- The column's header label can be changed from 'Details' to something more descriptive (i.e., Records, Accounts, Parts, Entries).
- The suffix text following a summary count can be changed from 'Rows' to something more descriptive (i.e., Loans, Transactions, etc.). The suffix is used in the group-level and overall summary row counts.
- A summary row may be included in the report with a caption (i.e., Total Parts: ).

To configure a grouped drill-down's details column options:

1. **OPTIONAL**: Choose a summary column display option. Refer to *Error! Reference source not found.* for the explanation of the options.
2. **OPTIONAL**: If the summary column display option of 'Grouping / Aggregate column' was selected, then choose a column from the drop-down menu.
3. **OPTIONAL**: If either one of the 'Auto-generated column' summary column display options were selected, then:
   a. Type an alternate **Column header** name for the summary column in the field provided.
   b. Type an alternate **Suffix** name for the summary hyperlink in the field provided.
   c. Enable the **Include summary row for Summary column** option and type a descriptive **Caption** in the field provided.
4. **OPTIONAL**: Click **OK** to retain the modification and exit the panel or continue configuring the other features of the grouping layer.
The application supports an unlimited number of grouping layers for any single report. Each layer can have multiple grouped columns, including any number of group aggregates.

On the first grouping layer, the option to display an “Expand All/Collapse All” link in the report is presented. The link, as the name implies, will allow the user to expand or collapse all drill levels of the report. Also on the first grouping layer, the behavior of the initial display of the report can be set to “collapsed” (the default) or “expanded”. The “expanded” option will cause the report to take longer to render.
To modify a grouping layer (all options):

1. Click on the Grouping tab.

2. Choose a different grouping style (e.g., Flat-Table, Drill-Down).
3. If more than one grouping layer has been defined, click the ▲ or ▼ icon to change grouping order in the report.
4. Click the icon associated to the grouping layer to be modified.
5. If modifying a grouped flat-table's first grouping layer, enable or disable the 'Insert a page break between groups of PDF Export' option.
6. If modifying the lowest level grouping layer:
   a. Move columns between the Available Columns list-box and the Grouped Columns list-box by selecting the column(s) and clicking the ▲ or ▼ icons to move the column from one list-box to the other.
   b. Move a column in the Grouped Columns list-box up or down by selecting the column(s) and click the ▲ or ▼ icon respectively.
7. If the grouping layer contain an aggregate:
   a. choose a different Aggregate function from the drop-down menu.
   b. If using the grouped flat-table style, modify the Label.
   c. If using the grouped drill-down style:
      i. Modify the Header.
      ii. Enable or disable the Include in sub-report option to include or not include the column in the sub-report.
   d. If more than one aggregate has been specified, click the ▲ or ▼ icon to arrange the order in which the aggregate will appear in the grouping column.
   e. Click X to remove the aggregate.
8. If using the grouped drill-down style:
   a. Choose a different summary column display option. Refer to Error! Reference source not found. for the explanation of the options.
   b. If the summary column display option of 'Grouping / Aggregate column' was selected, then choose a column from the drop-down menu.
   c. If either one of the 'Auto-generated column' summary column display options were selected, then:
      i. Type an alternate Column header name for the summary column in the field provided.
      ii. Type an alternate Suffix name for the summary hyperlink in the field provided.
   d. Enable the Include summary row for Summary column option and type a descriptive Caption in the field provided.

9. Click OK.

To delete a grouping layer:

1. Navigate to the Table component's Grouping panel.
2. Click the X icon associated to the grouping layer to be deleted.
**Table Settings**

The *Table Settings* tab offers the ability to control the general characteristics of the display table. It offers the ability to specify a table title and add paging controls for large result sets. Interactive paging controls can be added for the entire table as well as individual sub-reports in a drill-down style grouped table.

**To modify a tabular report's table settings:**

Click on the *Table Settings* tab.

The *Title* will be displayed above the display table in the generated report.

The *Show Record Count* option will display the number of rows returned at the bottom of the report.

The *Include row number* option will display a row number in the first column of the display table.

The *Paging Style* drop-down list will display the range of paging options. The default option is “Interactive Paging”. Select “None” to remove the paging controls from a report.

The *Paging Location* drop down list will display “Top”, “Bottom” and “Both”. This allows the user to set the location of the paging controls on the report.
The *Rows Per Page* and *Rows Per Sub-Report Page* attributes set the number of rows displayed on the display table and drill reports, respectively. Headers and summary rows are not considered in the number of rows per page. Only data rows are affected by these attributes.

The *Summary Row Location* is normally at the bottom of the display table. It may be set to the top of the display table just below the column headers.

Summary rows are typically displayed once at the bottom of the display table. The *Show Summary Row* option may be set to repeat the summary row on each page of the display table.

Drill Style grouped reports typically display the sub-reports within a minimum space. The *Table Width* attribute allows the sub-reports to display in a larger, fixed space. Set the *Table Width* to 100% to display drill-style reports across the full page.
CHAPTER 5
Crosstabs

Crosstab Configuration

Cross tabulation style reports give users the ability to display joint distributions of data from three separate columns. The results of the cross tabulation are displayed in table format. Every crosstab table consists of three columns.

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Use in Crosstab Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td>Populate the first row of the table. Each new value encountered in the crosstab column produces a new column in the crosstab table.</td>
</tr>
<tr>
<td>Label</td>
<td>Populate the first column of the table.</td>
</tr>
<tr>
<td>Values</td>
<td>Populate the aggregate data. The aggregate values are a sum, count, standard deviation or average of the fields in the Value column.</td>
</tr>
</tbody>
</table>

A crosstab report displaying sales totals per employee across years.
Users can also include crosstab summary data by adding an optional summary row or summary column.

In order to build a crosstab, you only need to pick three columns, *Header*, *Label* and *Value*, and decide how you want the value column be aggregated. These selections can be made in the *Crosstab Configuration* tab, with minimum attributes displayed.

You have many other options with the crosstab at your fingertips that you can use if needed. All of these other options can be accessed either on *Crosstab Configuration* page, with all attributes displayed, or on the *Crosstab Settings* tab. Below, we will discuss how to create a crosstab with its minimum requirements and later introduce the optional controls.

**To add a simple Crosstab table:**

1. From the Report Builder interface, click on the in the Insert ribbon at the top of the interface to add the Crosstab component to the report. Use drag-and-drop methods to place the crosstab into the report in a specific location in the Report Layout panel.

2. From the Crosstab Configuration panel's *Header Values Column* section, choose a header *Column* from the drop-down list.

3. From the *Label Values Column* section, choose a label *Column* from the drop-down menu.
4. From the Values Column section:
   a. Choose a value Column from the drop-down menu.
   b. Choose an Aggregate Function from the drop-down menu.

Your crosstab table is ready at this point.

**Note:**
1. The available aggregate functions are Sum, Average, Standard Deviation and Count.

**Exploring the options**

Click on the Show All Attributes icon to view the extended options on the Crosstab Configuration tab.

If the Header column is a date column, a drop down list of time periods will be displayed.

The options in the list include:
- None – display the date information in the header and aggregate the values by date
- Year – display the year information and aggregate the values by year
- Quarter – display the first day of the quarter and aggregate the values by quarter
- Fiscal Quarter – display the first day of the fiscal quarter and aggregate the values by fiscal quarter
- Month – display the first day of the month and aggregate the values by month

When all attributes are displayed on the Crosstab Configuration tab, the following extra options are available for Label column:
1. **Header** – This is the caption that is shown for the Label column on the title row of the crosstab. It changes every time you select a new Label column to reflect the name of the selected column. But you can change it to your desired text.

2. **Sortable** – When checked, this option changes the header of the Label column into a link that toggles the sort order of the crosstab rows by the values in the Label column.

3. **Linked** – This option may or may not be available, depending on whether the selected Label column has a pre-defined link associated with it or not.

4. **Format** – Allows you to choose a display format for the label column value.

5. **Alignment** – Sets a cell alignment for the label column values.

6. **Add a Layer** – Layering the Label column is an advanced function that automatically generates drill-down capability for the crosstab Label column. Read about it in the *Adding Drill-down Capability to Crosstabs* section.

The following extra options are available for Value column:
1. **Sortable** – When checked, this option changes the header of the Value column, if available (otherwise the link is put on Header column instead), into a link that toggles the sort order of the crosstab rows by the values in the Value column.

2. **Format** – Allows you to choose a display format for the Value column values.

3. **Alignment** – Sets a cell alignment for the Value columns.

4. **Style** – Adds conditional styling to values. This feature is explained fully in the [Conditional Styling of Crosstabs](#) section, later.

5. **Add Extra Value Columns** – Displaying multiple Value columns in a single crosstab table is an advanced feature that is described fully in the [Adding Multiple Value Columns](#) section.

The following options are available for adding a Summary Row:

![Summary Row]

1. **Include** – This checkbox adds or removes the Summary Row.
2. **Caption** – Type a caption, which describes the summary value.
3. **Aggregate Function** – Sets a cell alignment for the Value columns.
4. **Format** – Choose a display format for the summary value.

The following options are available for adding a Summary Column:

![Summary Column]

1. **Include** – This checkbox adds or removes the Summary Column.
2. **Header** – Type a caption, which describes the summary value.
3. **Aggregate Function** – Sets a cell alignment for the Value columns.
4. **Format** – Choose a display format for the summary value.
Notes:
1. The default sort order of the Label and Header column values is dictated by the sort order of the Data Source, however a crosstab is created dynamically and may not reflect the expected sort order of the Label and Header. This is particularly true when the data has missing information.
2. The available aggregate functions for Summary Row are: Sum, Average (of crosstab rows), Standard Deviation, Count (of crosstab rows), Count Distinct, Average of All Rows, and Count of All Rows.
3. The available aggregate functions for Summary Column are: Sum, Average (of value columns), Standard Deviation, Count (of value columns), Average of All Rows (used for the particular row of the crosstab pertaining to the summary value), and Count of All Rows (used for the particular row of the crosstab pertaining to the summary value).

Hint:
Crosstab tables can become quite long if there are a large numbers of distinct values in the crosstab Label and Header columns. If such is the case, limit the data by setting parameters on the data from the Data component's Parameters step.
Adding Drill-down Capability to Crosstabs

At times you may need to drill down to the details of a crosstab layer and find out how the top level values came to be.

You can add as many layers to a crosstab as you need in a very easy manner. Click on the **Add a Layer** button to display the following dialog.

![Crosstab Label Column](image)

Each layer consists of another crosstab table identical to the main layer, but with a different *Label* column. It makes sense to pick a column that can serve as the detail for the *Label* column in the layer right above it.

All available columns, except for those that have already been selected for the previous layers, can be selected for this new layer.

Just like the main layer, a *Header* can be entered for this new *Label Column* and it can be set as sortable and/or linked (if pre-defined as being linkable). Its format and alignment can also be determined.
Once a new layer has been defined, the default view of the *Label Values Column* panel will change to a grid.

![Label Values Column](image)

Layers can be moved up or down using ⬆️ and ⬇️ or by using drag-and-drop methods using the ⬇️ handle. They may be edited using 📚 and removed using ✗ action icons.

**Adding Multiple Value Columns**

If more than one *Value Column* is needed under crosstab, additional columns can be added by clicking the *Add Extra Value Columns* button. The following Crosstab Value Column dialog will be displayed.

![Crosstab Value Column](image)
The process is exactly like adding the first Value Column. The difference is in the Header option, which is missing for the first Value column. However, if multiple Value Columns have been defined, each column can have its own header, which will be displayed under the Header Column values.

Once a new Value Column has been defined, the default view of the Value Column panel will change to a grid.

_Value Columns_ can be moved up or down using ▲ or ▼ or by using drag-and-drop methods using the handle. They may be edited using ✏ and removed using ❌ action icons.

Separate Summary Row and Summary Column functions, as well as Styles, can be defined for each Value Column by using respective icons in each row of the grid. If either of these items has been defined, their icons will change to an “on” state.
Conditional Styling of Crosstabs

Conditional styling of crosstabs is very similar to that of a data table. The only difference is that styles can only be set, as well as depend on Value columns. Therefore the columns listed in the Column dropdown only consist of all selections for Value columns.

The following figure shows the results of conditional styling of “Product Sales Sum” to be red if the value is less than $5,000 and another green style set on Product Sales Average to show as green if sales average is greater than $1,000.
**Linking from Crosstabs**

If the administrator has set up links from any column that is used as the *Label* column for the crosstab, the "Linked" checkbox appears in the *Label Column* panel area. Since both links and drill-down are defined on the *Label* column, they cannot co-exist. Therefore only last layer of a crosstab can be linked. A link can be established to any other report or website. By checking *Linked* checkbox, the link is automatically enabled and the resulting report displays its *Label* columns as active HTML links that take you to the pre-determined report or web page, passing any required parameters to the report or site.

This feature can be used in lieu of drill-down, in order to display a report other than the detail crosstab report that is automatically generated by the application. The following figure displays a linked crosstab that opens up Google Maps and shows the map of the selected country, each time a country link is clicked on the report.
Crosstab Settings

The Crosstab Settings tab offers the ability to specify a crosstab table title and add and configure interactive paging controls for large result sets.

To modify a crosstab's settings:

Click on the Crosstab Settings tab.

The Title will be displayed above the display table in the generated report.

The Paging Style drop-down list will display the range of paging options. The default option is “Interactive Paging”. Select “None” to remove the paging controls from a report.

The Rows Per Page and Rows Per Sub-Report Page attributes set the number of rows displayed on the display table and drill reports, respectively. Headers and summary rows are not considered in the number of rows per page. Only data rows are affected by these attributes.
CHAPTER 6
Charts

Chart Settings

The Report Builder charting components allow various types of charts to be built to bolster a report. Charts provide a visual representation of data utilizing different styles and types. The following chart types are supported in the application:

- Pie
- Bar
- Line/Spline/Area
- Scatter

In addition, animated versions of these chart styles are available. Since animated charts are not exportable, they are presented in a separate section of the interface.

To add a chart to a report, click on the Insert tab to display the reporting elements and click on the Chart option. The following chart select panel will be displayed:
The chart panel offers categories of charts down the left side and a scrollable area on the right side with all of the basic charting options. Clicking on a category of chart will reposition the panel to display the selected options. Click on the desired chart type to add it to the report.

When a chart is added to a report definition, a tab called Chart Settings is created with the appropriate attributes for the chart type. If multiple charts are added there will be multiple Chart Settings tabs that follow the sequence of the charts in the Report Layout panel.

The Chart Settings tab will appear similar to the following (Bar Chart example):

![Bar Chart Example](image)

Notice that a bar chart image was added to the report layout area. The Chart Settings tab, by default, displays the most common and minimum attributes necessary to render a complete chart.

The × icon in the report layout panel will delete the chart when clicked.

The ⚡ icon the report layout panel will present the chart selection panel and allow a different chart type to be selected. To the extent possible, the attributes of the current chart will be replicated in the replacement chart.
Click on the *Show All Attributes* icon to display the advanced settings available for the chart. Using the same example the *Chart Settings* tab will be redisplayed as:

Notice the scroll bar down the right side of the *Chart Settings* tab. Scroll down to view and set the advanced attributes for the chart.

Chart attributes are grouped according to functional area. Following are the general areas that may apply to charts:

- Label Column
- Label (x-axis) Column
- Label (x-axis) Scaling
- Data Column
- Data (y-axis) Column
- Data (y-axis) Scaling
- Legend
- Relevance
- Trend Line
- Crosstab Column
- Style

**Note:**

*Not all charting attribute functional areas are available for all chart types. In addition, attributes in each functional area may be different based on the chart type selected and the data type of the selected columns.*
Three attributes are presented as stand-alone properties of the chart; *Title*, *Show Data Values*, and *Allow Resizing*.

The *Title* attribute value will be displayed as a chart title over the displayed chart.

The *Show Data Values* attribute will include the numeric data values driving the chart elements in the chart display. By default this attribute is enabled.

The *Allow Resizing* attribute will present resizing bars around the displayed chart so that the end user can adjust the display.

**Attribute Functional Areas**

*Label Column area* – The *Label Column* area allows the user to select the column to be used for a pie chart label. Data values will be aggregated based on this column.

*Label Column (x-axis) area* – For X/Y charts, the Label Column area allows the user to select the column to be displayed along the x-axis, specify the caption for the x-axis and select the format.

If the Label Column for the x-axis is a date column, a drop down list of time periods will be displayed (*Apply Time Period*). Data will be aggregated according to the time period.

The options in the list include:

- None – display the date information on the x-axis and aggregate the values by date
- Year – display the year information on the x-axis and aggregate the values by year
- Quarter – display the first day of the quarter on the x-axis and aggregate the values by quarter
- Fiscal Quarter – display the first day of the fiscal quarter on the x-axis and aggregate the values by fiscal quarter
- Month – display the first day of the month on the x-axis and aggregate the values by month

**Label (x-axis) Scaling** area – the user may override the default scaling of the x-axis by entering values for the **Lower** and **Upper Bound** attributes.

If the column used for the x-axis content is numeric, the **Linear Numeric** attribute is available and if enabled will provide fixed numeric intervals along the x-axis.

![Label (x-axis) Scaling](image)

If the column used for the x-axis content is date oriented, the **Linear Time** attribute is available and if enabled will provide fixed time intervals along the x-axis.

![Label (x-axis) Scaling](image)

**Data Column** area – The **Data Column** area allows the user to select the data to be shown in the chart, select the format from the suite of numeric formats, and select the aggregation function to be applied to the data.

![Data Column](image)

**Data Column (y-axis)** area – For X/Y charts, the Data Column area allows the user to select the column used for the data displayed along the Y-axis. In
addition the user can specify a caption for the Y-axis, select a format for the data values, select an aggregation function, and indicate whether the data values should be displayed as a percentage.

**Data Column (y-axis)**
- **Column:** Order ID
- **Caption:** Order ID
- **Format:** (none)
- **Aggregate:** Count
- **Use Percentage:**

**Data (y-axis) Scaling area** - the user may override the default scaling of the y-axis by entering values for the *Lower* and *Upper Bound* attributes.

**Legend area** – The Legend area allows the user to indicate whether a legend should be displayed for the chart. For some chart types the user may also select the legend position relative to the chart.

**Legend**
- **Include Legend:**
- **Position:** Side
Relevance area – a Relevance filter allows the user to specify data thresholds to be included in the chart.

Enable/Disable a relevance filter by clicking on the Use Relevance Values checkbox. Identify the relevance scale by clicking on either the Top N rows or Percentage options. Enter the threshold value in the area provided.

For example, only the top 75% of data in the chart could be relevant. In this case, check the Use Relevance Values checkbox, enter a value of 75 in the value field, and click the Percentage radio button.

Alternatively, only the top 5 rows of data in the chart could be relevant. In this case, enable the Use Relevance Values feature, enter a value of 5 in the value.

Trend Line area – the Trend Line area allows the user to indicate that a trend line should be displayed on the chart.

Crosstab Column area – the Crosstab Column area allows the user to identify a second column of data to be represented in the chart.
**Style area** – the Style attributes allow the report designer to change the size and spacing regarding the display element. Two examples of Style areas follow:

**Pie Chart Style**

![Pie Chart Style Example]

**X/Y Chart Style**

![X/Y Chart Style Example]

The Size attribute drop-down list offers three standard sizes; small, medium and large. Selecting one of the standard sizes will reset the other size attributes. If the size attributes are over-ridden, the Size attribute will be set to Custom.

Color may be set by exercising the color wheel or selecting colors from the drop-down list, depending on the chart type.
Definition of different areas of a chart have been described in the figure below.
The *Interactive Data View* (IDV) is an analysis tool included with the application, and provides a versatile way to interact with data in a chart or table. The IDV chart can display data in a table, pie chart, grid chart, line chart or area chart. Use the IDV to perform quick calculations on the data or create "what-if" scenarios by filtering columns out of the report.

**Note:**
_IDV Charts require the Java Runtime Engine browser plug-in. The JRE can be downloaded from [http://java.sun.com/j2se/1.5.0/download.jsp](http://java.sun.com/j2se/1.5.0/download.jsp)._
The Report Builder provides a wizard for configuring the IDV; however, most of these settings only apply to the initial view of the IDV. The IDV is a highly interactive and dynamic reporting component, and most of these options can be changed after it loads in the browser.
The Interactive Data View interface.

**Filter the Crosstab and Label Columns:**

The IDV provides the Label Selector and Crosstab Selector to dynamically filter data presented in the data view. Select a single record or hold CTRL to select multiple records. The IDV is updated each time a record is selected or removed.
Find Data Values:

Move the cursor over an item in the label column to see all the corresponding data values from the data column.

The data values for Leverling are displayed across the IDV.

Alternatively, an individual element can be selected to view its associated label. Move the cursor across the chart to view individual data values.
Scale the Chart:

The IDV chart is automatically scaled to view all records in the crosstab column (x-axis). The crosstab column may contain hundreds of records, causing an undesirable data view.

The View menu provides other ways to dynamically change the way data is displayed in the chart. Data can be presented in table form, chart form and chart/table form. Other flexible view options include transposing the x- and y-axes, reversing the columns and restoring the initial order.
Transpose the X- and Y-Axes:

Transposing the x- and y-axes swaps the label and crosstab columns.

The IDV allows the user to dynamically swap the label and crosstab columns without modifying the chart from the Report Builder.
Sort the Data Table:

From the **Table** view, users can sort records in the data column for each record in the crosstab column.

<table>
<thead>
<tr>
<th>Row #</th>
<th>Line Item</th>
<th>Unit</th>
<th>1997</th>
<th>1996</th>
<th>1998</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fuller</td>
<td>Freight</td>
<td>$3,795.00</td>
<td>$973.00</td>
<td>$3,930.00</td>
</tr>
<tr>
<td>2</td>
<td>Callanan</td>
<td>Freight</td>
<td>$2,933.00</td>
<td>$1,260.00</td>
<td>$3,292.00</td>
</tr>
<tr>
<td>3</td>
<td>Leverling</td>
<td>Freight</td>
<td>$6,920.00</td>
<td>$879.00</td>
<td>$3,085.00</td>
</tr>
<tr>
<td>4</td>
<td>King</td>
<td>Freight</td>
<td>$3,240.00</td>
<td>$667.00</td>
<td>$2,710.00</td>
</tr>
<tr>
<td>5</td>
<td>Peacock</td>
<td>Freight</td>
<td>$6,653.00</td>
<td>$1,969.00</td>
<td>$2,690.00</td>
</tr>
<tr>
<td>6</td>
<td>Davolioe</td>
<td>Freight</td>
<td>$4,596.00</td>
<td>$1,871.00</td>
<td>$2,415.00</td>
</tr>
<tr>
<td>7</td>
<td>Dodsworth</td>
<td>Freight</td>
<td>$1,046.00</td>
<td>$532.00</td>
<td>$1,749.00</td>
</tr>
<tr>
<td>8</td>
<td>Buchanan</td>
<td>Freight</td>
<td>$1,193.00</td>
<td>$1,334.00</td>
<td>$1,369.00</td>
</tr>
<tr>
<td>9</td>
<td>Suyama</td>
<td>Freight</td>
<td>$2,111.00</td>
<td>$766.00</td>
<td>$899.00</td>
</tr>
</tbody>
</table>

Values for 1998 are dynamically sorted in descending order.

Click the column headers to sort the data in ascending or descending order.
The Chart Type menu gives users the ability to visualize data using different types of charts. Charts are either 2D or 3D and are one of the following:

- Line
- Clustered Bar
- Stacked Bar
- Stacked Area
- Pie
The Calculate menu provides several functions to perform calculations on the IDV. The calculations available are:

- Original Data (restores IDV to original state)
- Statistical Summary
- Average
- Column Average
- Median
- Maximum
- Minimum
- Sort Ascending
- Sort Descending
- Incremental % Change
- Cumulative % Change
- Percent of Maximum
- Percent of Minimum
- Percent Deviation from Mean
- Percent Deviation from Column Mean
- Absolute Deviation from Mean
- Absolute Deviation from Column Mean
- Percent of Total
- Percent of Column Total
- Add Multiple Datasets
- Sum
- Cumulative Sum
- Normalize
- Rank
- Count
- Count Distinct
- Standard Deviation
- Column Standard Deviation
Heat maps are useful for giving business users quick views of large amounts of data to find trends and anomalies at-a-glance. It would be very difficult to view and comprehend information about 2,000 items in a pie chart; a heat map, however, makes this possible. Heat maps can show relationships among hundreds or thousands of items in hierarchies with rectangular spaces divided into regions. Each region is divided again to correspond to each level in the hierarchy. Business users easily interact with these hierarchical, colorful regions to get more information.

The Map of the Market heat map of daily stock quotes by SmartMoney.

Heat maps are especially useful when an organization has numerous facts to analyze, such as many sales regions, many manufacturing plants or hundreds of product lines and wants to monitor the complex activities among those many products, projects or salespeople.
Heat maps are comprised of multiple cells that have a varying size and color. Each cell has a specific label so that users can determine what each cell represents. The size, color and label for each cell are determined by values from three different points of data. In order to fully populate a heat map, select three distinct data columns for the label, cell size and cell color.

A cell is created for each distinct product name in the ProductName column. The size of the cell is determined by the corresponding value from the Revenue column; larger values produce larger cells. The color of the cell is determined by the value of the Order Count column.

Note:
Numeric data columns must be selected for the Cell Size and Cell Color columns.
The heat map color slider displays gradients of 3 different colors.

The Heat Map component also includes an interactive color slider that allows dynamic modification to the gradients of three distinct colors that correspond with values from the cell color column. The left color corresponds to low values, the center color corresponds to middle values, and the right color corresponds to high values. The gradients help establish the relationship each cell color value has to another. In the example, the highest values will get the purest shade of green. Slide the control to the left to single out the lowest value. Slide the control to the right to find the cell with the highest value.
The application allows a header, custom labels and images to be added to a report and the overall look and feel of the report to be configured (e.g., report style, page size, print orientation).

**Report Header**

By default, a report header is included in the standard report template with the Date and Time options enabled.

**Default report header**

Click from the Insert ribbon to add the Header to a report. A Header tab will be created. A report may only have one Header.

**Header Information**

- Date:
- Time:

Header Information tab with Date and Time options not enabled.

**Notes:**

1. Since only one *Header* may be specified in a report, the icon may be disabled and appear as.
2. If a *Header* is added without the Date and Time options enabled, then only a report name will appear in the header.
3. The font and background colors of the header are dictated by the Report Style selected (e.g., Classic) in *Report Settings.*
Adding Labels

The Label component offers the ability to add custom messages and text in the report. An unlimited number of labels above or below other reporting components can be added. Use labels to add text to the report that would otherwise be too long for a table or chart caption.

A bar chart with a red label beneath it.

Click **A** to add a Label to the report definition. Alternatively, use the drag-and-drop method to place the label in the Report Layout panel. A corresponding Label Information tab will be created.

Type the text for the Label in the field provided.
Choose a Label Type from the drop-down menu where Simple always centers the text and Full Width uses the full available width of the report.

OPTIONAL: Choose a text-style orientation from the Style drop-down menu (e.g., red, green, Align Text Left, etc.).

Adding Images

The Image component offers the ability to add an image to the report layout. An unlimited number of images above or below other reporting components can be added. Use images to display a company logo, disclaimer or warning or to bring emphasis to a new or updated section of a report. The image may be added to the report from a file or via a URL. Image files must be 1 megabyte or smaller and be one of the following file types: JPG, JPEG, GIF, BMP. Animated images are supported.

A report with an image appearing before the tabular report.

Click ![Image](image.png) to add an Image to the report definition. An Image Information tab will be created.

Choose a Source location to retrieve the image from. If File is selected then click a "source" button. If the From My Computer button is clicked then click Browse to locate and select a file from your computer. When done, click OK. If the From Server button is clicked then select an image and then click OK.
If URL is selected then specify the URL path to the image and then click OK.

OPTIONAL: Choose an image-type orientation style from the Style drop-down menu.

**Notes:**
1. Images selected from your computer are automatically uploaded to the application server for later use by all users.
2. Images require a specific style to align (e.g., Align Image Center). If one is not available, contact the system administrator.
Report Settings

The Settings ribbon offers the ability to control report paging and style by clicking on the or icons, respectively.

The *Printable Paging* dialog appears as:

![Printable Paging Dialog](image)

From this dialog the *Page Size* and *Orientation* may be modified. Page numbers may appear in the displayed report based on the *Show Page Number* checkbox.

The available printable page sizes are:

- Letter
- Legal
- Executive
- A4
- A5

The *Report Style* dialog appears as:

![Report Style Dialog](image)

Select a style from the dropdown list and click on the OK button.
The *Export Options* component allows links to be added to the bottom of the report that give users the ability to publish reports. Reports can be printed from a browser, exported to popular formats such as Excel and PDF, and added to the archive for other users to view.

Click on the ![insert ribbon](image) from the Insert ribbon to add the *Export Options* tab to the report definition.

Export capability is added to the report by enabling the individual export options.
The below listed export options are available to report developers to provide to the end user. None, some or all of the icons may be visible to the end user based on availability and user permissions.

- Searchable Report
- Printable Paging
- Export to Excel
- Export to Word
- Export to PDF
- Export to CSV
- Export to XML
- Add to Archive
- Send Email

**Notes:**
1. Microsoft Office is integrated with Internet Explorer. Exporting the reports in an Office format opens a new browser window to edit and save the report. Microsoft Office is required to edit the reports from a browser window.
2. The various Export Options are available in the rendered report to users with the respective Right to add the export option(s) to the report from the Report Builder.
*Searchable Report* presents the report in a single-page view. The CTRL-F shortcut is then available to search the entire report overlooking pagination.

*Printable Paging* presents the report in a view that is suitable to print.

*Export to Excel* saves the report in Microsoft Excel format. If Microsoft Excel is installed, the report can be edited as an Excel spreadsheet from the browser window.

*Export to Word* saves the report in Microsoft Word format. If Microsoft Word is installed, the report can be edited as a Word document from the browser window.

*Export to PDF* saves the report as a PDF (Portable Document Format), which can be viewed with Adobe Reader and edited with Adobe Acrobat.

*Export to CSV* saves the report to a comma-delimited format. The file can be viewed with Microsoft Excel.

*Export to XML* saves the report data in XML format. The XML dataset is viewable from Internet Explorer.

*Add to Archive* saves a copy of the current report to the archive. Archiving is a great way to backup a report before it is modified.

*Send PDF Report by Email* exports the report to PDF format and attaches it to emails sent to selected recipients.

**Note:**
Archiving and XML exports are not always available when creating a new report. Contact the system administrator for assistance with archiving and XML exports.
**Searchable Report**

Searchable Report opens a new browser window, displaying the entire report on one page.

**Note:**
Reports containing drill-down groupings will not be expanded.

---

**Customer Information**

<table>
<thead>
<tr>
<th>Customer ID</th>
<th>Date: Tuesday, January 25, 2005</th>
<th>Time: 10:09:15 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Customer ID**

<table>
<thead>
<tr>
<th>Ship Country</th>
<th>Order ID</th>
<th>Product ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>11011</td>
<td>17</td>
<td>$1.46</td>
<td>1</td>
<td>1.46</td>
</tr>
<tr>
<td>Germany</td>
<td>11011</td>
<td>71</td>
<td>$21.56</td>
<td>20</td>
<td>431.20</td>
</tr>
</tbody>
</table>

Quantity Count: 2

Unit Price Average: $11.25

Freight Sum: $2.83

---

** Inquiry**

<table>
<thead>
<tr>
<th>Order Date</th>
<th>Shipped Date</th>
<th>Freight</th>
<th>Ship Country</th>
<th>Order ID</th>
<th>Product ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/20/1998 12:00:00 AM</td>
<td>4/21/1998 12:00:00 AM</td>
<td>$34.66</td>
<td>Inc</td>
<td>11016</td>
<td>35</td>
<td>$12.50</td>
<td>15</td>
<td>187.50</td>
</tr>
<tr>
<td>4/20/1998 12:00:00 AM</td>
<td>4/21/1998 12:00:00 AM</td>
<td>$34.66</td>
<td>Inc</td>
<td>11016</td>
<td>36</td>
<td>$19.00</td>
<td>15</td>
<td>285.00</td>
</tr>
</tbody>
</table>

Quantity Count: 2

Unit Price Average: $35.75

Freight Sum: $58.00

---

Press CTRL-F to open the Find window in most of the popular Internet browsers. Type the name of the record to search for and click **Find Next** to jump to the first occurrence of that record.

The main difference between the **Searchable Report** view and the **Printable Paging** view is how the webpage is configured for printing. Printing a report from the Searchable Report view prints the entire report as one page, cutting off any graphics or records as the report prints. Use **Printable Paging** to print reports properly.
Printable Paging

*Printable Paging* opens a new browser window formatted for printing, avoiding the "cutoff" scenario that commonly occurs when printing web pages.

**Note:**
Reports containing drill-down groupings will not be expanded.

---

**Table 1: EASTC**

<table>
<thead>
<tr>
<th>Order Date</th>
<th>Shipped Date</th>
<th>Freight</th>
<th>Ship Country</th>
<th>Order ID</th>
<th>Product ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/25/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$74.00</td>
<td>UK</td>
<td>11024</td>
<td>26</td>
<td>$31.23</td>
<td>12</td>
<td>$374.74</td>
</tr>
<tr>
<td>4/25/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$74.00</td>
<td>UK</td>
<td>11024</td>
<td>35</td>
<td>$2.50</td>
<td>30</td>
<td>$75.00</td>
</tr>
<tr>
<td>4/25/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$74.00</td>
<td>UK</td>
<td>11024</td>
<td>65</td>
<td>$11.05</td>
<td>21</td>
<td>$442.05</td>
</tr>
<tr>
<td>4/19/1998 12:00:00 AM</td>
<td>4/19/1998 12:00:00 AM</td>
<td>$74.00</td>
<td>UK</td>
<td>11024</td>
<td>71</td>
<td>$21.50</td>
<td>50</td>
<td>$1075.00</td>
</tr>
<tr>
<td>4/24/1998 12:00:00 AM</td>
<td>5/1/1998 12:00:00 AM</td>
<td>$47.00</td>
<td>UK</td>
<td>11047</td>
<td>1</td>
<td>$15.00</td>
<td>25</td>
<td>$450.00</td>
</tr>
<tr>
<td>4/24/1998 12:00:00 AM</td>
<td>5/1/1998 12:00:00 AM</td>
<td>$47.00</td>
<td>UK</td>
<td>11047</td>
<td>5</td>
<td>$21.35</td>
<td>30</td>
<td>$640.50</td>
</tr>
<tr>
<td>5/2/1999 12:00:00 AM</td>
<td>5/2/1999 12:00:00 AM</td>
<td>$299.00</td>
<td>UK</td>
<td>11096</td>
<td>55</td>
<td>$20.00</td>
<td>35</td>
<td>$500.00</td>
</tr>
</tbody>
</table>

**Quantity Count:** 7  
**Unit Price Average:** $19.95  
**Freight Sum:** $509.00

---

**Table 2: BRUSN**

<table>
<thead>
<tr>
<th>Order Date</th>
<th>Shipped Date</th>
<th>Freight</th>
<th>Ship Country</th>
<th>Order ID</th>
<th>Product ID</th>
<th>Unit Price</th>
<th>Quantity</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/8/1998 12:00:00 AM</td>
<td>4/8/1998 12:00:00 AM</td>
<td>$79.00</td>
<td>Austria</td>
<td>11086</td>
<td>26</td>
<td>$45.65</td>
<td>70</td>
<td>$3195.50</td>
</tr>
<tr>
<td>4/8/1998 12:00:00 AM</td>
<td>4/8/1998 12:00:00 AM</td>
<td>$79.00</td>
<td>Austria</td>
<td>11086</td>
<td>34</td>
<td>$14.00</td>
<td>90</td>
<td>$1260.00</td>
</tr>
<tr>
<td>4/25/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$79.00</td>
<td>Austria</td>
<td>11086</td>
<td>71</td>
<td>$21.50</td>
<td>21</td>
<td>$451.50</td>
</tr>
<tr>
<td>4/3/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$75.00</td>
<td>Austria</td>
<td>11017</td>
<td>3</td>
<td>$15.00</td>
<td>25</td>
<td>$375.00</td>
</tr>
<tr>
<td>4/3/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$75.00</td>
<td>Austria</td>
<td>11017</td>
<td>59</td>
<td>$55.00</td>
<td>140</td>
<td>$3550.00</td>
</tr>
<tr>
<td>4/25/1998 12:00:00 AM</td>
<td>4/25/1998 12:00:00 AM</td>
<td>$75.00</td>
<td>Austria</td>
<td>11017</td>
<td>70</td>
<td>$15.00</td>
<td>30</td>
<td>$450.00</td>
</tr>
<tr>
<td>5/5/1998 12:00:00 AM</td>
<td>5/5/1998 12:00:00 AM</td>
<td>$259.00</td>
<td>Austria</td>
<td>11072</td>
<td>2</td>
<td>$15.00</td>
<td>6</td>
<td>$152.00</td>
</tr>
<tr>
<td>5/5/1998 12:00:00 AM</td>
<td>5/5/1998 12:00:00 AM</td>
<td>$259.00</td>
<td>Austria</td>
<td>11072</td>
<td>41</td>
<td>$6.50</td>
<td>40</td>
<td>$386.00</td>
</tr>
<tr>
<td>5/5/1998 12:00:00 AM</td>
<td>5/5/1998 12:00:00 AM</td>
<td>$259.00</td>
<td>Austria</td>
<td>11072</td>
<td>50</td>
<td>$16.25</td>
<td>22</td>
<td>$577.50</td>
</tr>
</tbody>
</table>

---

**Page numbers are placed throughout the webpage indicating the portions of the report printed on a particular page.**

**Note:**
The progress of the page formatting will display in the lower left corner of the browser window. It may take a few seconds to format a large report for printable paging.

Click the *print* icon from the web browser to print the report.
**Export to Excel**

*Export to Excel* opens a new browser window, displaying the report in Microsoft Excel (spreadsheet) format.

**Note:**
*Reports containing drill-down groupings will not be expanded when exported.*

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th></th>
<th>B</th>
<th></th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Date: Friday, June 22, 2007</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Orders by Employee</td>
<td>Time: 11:31:30 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>LName</td>
<td>CustomerID</td>
<td>OrderID</td>
<td>UnitPrice</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Buchanan</td>
<td>BERGS</td>
<td>10654</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>$22.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>$10.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td>$7.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>Sum Unit Price $47.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>10866</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td>$19.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td>$4.50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td></td>
<td></td>
<td>$25.69</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>Sum Unit Price $49.39</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Buchanan</td>
<td>BLONP</td>
<td>10297</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
<td></td>
<td>$14.40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td></td>
<td></td>
<td>$27.80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td></td>
<td></td>
<td></td>
<td>Sum Unit Price $42.20</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The report is exported to Microsoft Excel as a spreadsheet.

If Microsoft Excel is installed, the report opens as an Excel spreadsheet. Select rows or columns for sorting, copying, pasting, etc., and perform many other typical Excel functions.

**Hint:**
*Click View > Toolbars to add standard Excel toolbars to the browser window.*

Save the report in Excel format by clicking the File menu and choosing **Save as**. Choose a name and location for the file and click **Save**.
Export to Word

Export to Word downloads the report into a Microsoft Word document. A temporary name is given to the file, with the Word file extension (.doc).

Notes:
1. Reports containing drill-down groupings will not be expanded when exported.
2. Due to a MS-Word limitation, if a report contains more than 50 columns, then only the first 50 columns will be exported.

The report is exported to Microsoft Word format.

If Microsoft Word is installed, the report opens as a Word document. Edit the report as a Word document or save the report unedited.

Hint:
Click View > Toolbars to add standard Word toolbars to the browser window.

Save the report in Word format by clicking the File menu and choosing Save as. Choose a name and location for the file and click Save.
Export to PDF

Export to PDF opens the report in the current browser window as a PDF document viewable with Adobe Reader.

**Note:**
Reports containing drill-down groupings will not be expanded when exported. In order to view PDF reports from the browser, the Adobe Acrobat Reader plug-in must be installed. See the system administrator for additional help.

The report is exported to Adobe Portable Document Format.

The Adobe toolbar is displayed across the top of the report, providing many typical PDF functions. Users can save, print and search the entire document.

Save the report in PDF format by clicking **Save a copy** from the Adobe toolbar. Choose the name and location and click **Save**. The default file type is **Adobe PDF Files (*.pdf)**.
Export to CSV

Export to CSV opens a new browser window and displays the report in comma-separated values within a spreadsheet (comma-delimited text file).

Note:
Reports containing drill-down groupings will not be expanded when exported.

Hint:
The CSV format is viewable by a variety of applications. It is best viewed by spreadsheet, database, and text-editing applications.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Total Sales</td>
<td>Product ID</td>
<td>Total Unit</td>
<td>Total Quan</td>
<td>Average Discount</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>33952</td>
<td>27</td>
<td>$105.30</td>
<td>90</td>
<td>8.33%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>62106</td>
<td>63</td>
<td>$210.60</td>
<td>209</td>
<td>8.33%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>62354</td>
<td>15</td>
<td>$35.60</td>
<td>122</td>
<td>1.67%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>63340</td>
<td>37</td>
<td>$40.40</td>
<td>125</td>
<td>5.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>63485</td>
<td>48</td>
<td>$71.40</td>
<td>138</td>
<td>10.63%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>84775</td>
<td>66</td>
<td>$123.40</td>
<td>239</td>
<td>3.13%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>90217</td>
<td>43</td>
<td>$301.20</td>
<td>174</td>
<td>0.66%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>105419</td>
<td>5</td>
<td>$186.10</td>
<td>298</td>
<td>7.60%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>106994</td>
<td>50</td>
<td>$49.90</td>
<td>235</td>
<td>2.90%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>107456</td>
<td>67</td>
<td>$37.20</td>
<td>184</td>
<td>5.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>128318</td>
<td>3</td>
<td>$114.00</td>
<td>328</td>
<td>1.67%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>129064</td>
<td>6</td>
<td>$290.00</td>
<td>301</td>
<td>3.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>134935</td>
<td>26</td>
<td>$473.30</td>
<td>252</td>
<td>2.69%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>137177</td>
<td>74</td>
<td>$114.00</td>
<td>297</td>
<td>5.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>138971</td>
<td>8</td>
<td>$504.00</td>
<td>372</td>
<td>8.54%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>144703</td>
<td>62</td>
<td>$561.60</td>
<td>360</td>
<td>2.60%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>148955</td>
<td>73</td>
<td>$301.00</td>
<td>293</td>
<td>4.71%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>149550</td>
<td>22</td>
<td>$295.60</td>
<td>348</td>
<td>2.14%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>149684</td>
<td>46</td>
<td>$120.20</td>
<td>608</td>
<td>7.60%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>150345</td>
<td>12</td>
<td>$518.80</td>
<td>344</td>
<td>8.43%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>160095</td>
<td>32</td>
<td>$630.00</td>
<td>397</td>
<td>7.33%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>181139</td>
<td>56</td>
<td>$214.65</td>
<td>454</td>
<td>10.29%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>192053</td>
<td>25</td>
<td>$290.20</td>
<td>316</td>
<td>8.61%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>208589</td>
<td>54</td>
<td>$346.40</td>
<td>506</td>
<td>5.00%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>212436</td>
<td>4</td>
<td>$413.60</td>
<td>465</td>
<td>7.60%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>213510</td>
<td>22</td>
<td>$187.40</td>
<td>660</td>
<td>3.75%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>22857</td>
<td>49</td>
<td>$360.00</td>
<td>620</td>
<td>3.10%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>232411</td>
<td>47</td>
<td>$191.90</td>
<td>465</td>
<td>7.36%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>233515</td>
<td>14</td>
<td>$459.65</td>
<td>404</td>
<td>8.73%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>244710</td>
<td>57</td>
<td>$417.30</td>
<td>434</td>
<td>2.63%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>254972</td>
<td>44</td>
<td>$405.20</td>
<td>601</td>
<td>5.04%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>259339</td>
<td>61</td>
<td>$666.90</td>
<td>603</td>
<td>7.08%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The report is exported to CSV format and viewed by the Microsoft Excel browser plug-in.

Save the report in CSV format by clicking the File menu and choosing Save as. Choose the filename and location and click Save. The default file type is CSV (comma delimited).
**Export to XML**

Export to XML opens a new browser window and displays all the data presented in the report in XML (Extensible Markup Language) format.

The report data is exported to XML format and viewed by Internet Explorer.

Save the report data in XML format by clicking the File menu and choosing **Save as**. Choose the filename and location, and then choose **XML Files** from the drop-down menu. Click **Save** to create the XML file.
**Add to Archive**

*Add to Archive* creates a new copy of the current report in the associated archive.

A copy of the *Sales by Employee w/Unit Price Greater Than or Equal to* report is added to the archive.

The date and timestamp are updated when the archiving footer link is clicked. For this reason, the timestamp of the report at runtime may not match the timestamp in the archive.
Send PDF Report By Email

Send PDF Report by Email opens a form where the email can be composed and recipients specified.

Manually enter an email recipient(s) or click the respective icon to view and select from a list of application users. Specify a Subject and message. When done, click Send to send the email with a PDF version of the report attached. Click Cancel to cancel this export action.

Notes:
1. The 'From' email address is defaulted to the email address specified in the logged in user's Profile.
2. All fields except for Cc and Bcc are required.
The Report Management button displays the main page of the application.

A list of reports is available under the Personal Reports and Shared Reports tabs. If no reports have been created, this list is empty.

Click the name of the report to launch it in a new browser window.

Any reporting components that reference the ShipCountry data column will show only orders shipped to Mexico.

The figure above shows a field requesting a parameter value. Runtime parameters are defined on the Select or Modify Data Sources dialog under the Filter tab. Click on the Modify Data Source button to access the dialog. A default value is chosen during the report-creation process and can be changed by the user.
Note:
Date values less than 01/01/1753 may not be specified.

There are two options for running the report.

- **Run and Hide Parameters** - Run the report and hide parameter input box
- **Run** - Run the report and leave parameter input box visible

**Hint:**
*If the report contains numerous parameters, click Run and Hide Parameters to provide more screen space for the report. Run the report again to input additional parameters.*

*Run and Run and Hide Parameters* affect the parameters for the report. Any additional settings specified in the Report Builder are left intact.

Note:
Run and Run and Hide Parameters are only available by placing a check in the 'Ask' checkbox when defining parameters.

Cascading filter parameters produce one or more drop-down menus at runtime. The value selected from the first drop-down menu is used to filter the second drop-down menu and so on. The last parameter is selected from a list and passed to the report when the user clicks **Run**.

<table>
<thead>
<tr>
<th>High School Teachers</th>
<th>Date: Thursday, June 29, 2006 Time: 6:02:36 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>State</strong></td>
<td></td>
</tr>
<tr>
<td>Virginia</td>
<td></td>
</tr>
<tr>
<td><strong>County</strong></td>
<td></td>
</tr>
<tr>
<td>Fairfax</td>
<td></td>
</tr>
<tr>
<td><strong>City</strong></td>
<td></td>
</tr>
<tr>
<td>Herndon</td>
<td></td>
</tr>
<tr>
<td><strong>HighSchoolID in list</strong></td>
<td></td>
</tr>
<tr>
<td>Herndon HS</td>
<td></td>
</tr>
<tr>
<td>Woodson HS</td>
<td></td>
</tr>
</tbody>
</table>

Cascading filter parameters produce multiple, dependent drop-down menus.
A drill-down report with a sortable **Customer ID** column.

The column header, **Customer ID** is displayed as a link. The heading link allows the user to sort that column. The sort option was configured in the Column Configuration panel of the Table component in the Report Builder.

Drill-down reports are created in the Grouping step of the Table wizard. The **Customer ID** column is the grouping column and each record in the Details column is a hyperlink. Clicking each link in the Details column reveals the sub-report.

Export options always appear at the bottom of a report.

Export options give users the ability to export reports to popular formats such as Microsoft Excel and Adobe PDF. Users can also search the report, print from the browser and add the report to the archive. Add or remove export options through the Report Builder.

**Note:**
The various export options will appear if the user viewing the report has Rights to add the respective export option(s) to the report in the Report Builder.
CHAPTER 12
Managing Reports

As reports are created in the application, it is important to learn how to organize and manage them. This chapter focuses on the various actions a user can take on each report. The application provides the following actions:

- Modify Report/Folder
- Rename Report
- Copy Report
- Move Report
- Modifying Scheduling Information
- Change Subscription to Report
- View Archives
- Modify Report in Web Studio*
- View Dependencies

* Web Studio is not available in the Java version.

Some actions can be performed in batch mode by enabling the checkbox adjacent each report or report folder. Users can perform the following actions in batch mode:

- Delete Reports/Folders
- Copy Reports
- Move Reports

**Note:**
Some of the actions listed above are not available to all users and/or all reports/dashboards. Contact the system administrator if a particular action is needed but not available.
Organizing Reports

Users can create and store reports in the root folder or within an existing folder to store reports. Administrators can create folders in the Shared Reports area, which can be accessed by all users or limited to users based on the role(s) assigned to the user.

To create a new folder to store reports:

1. Navigate to a report area (e.g., Personal Reports, Shared Reports) or folder in which the new folder is to be created.
2. Hover the mouse over the Add button and select Folder from the list.
3. Type the name of the new folder into the Folder field.
4. Optional: Type a description into the Description textbox.
5. Optional: As a designated administrator of a User Group and from the Shared Reports area, specify restricted access to this folder based on a user's role. By default, all roles have access to the folder. To limit access:
   a. Select the Specific Roles option.
b. Move roles between the Available Roles and the Roles With Access list-boxes by double-clicking on the listed role or by selecting the role and then clicking the ► (right) or ◄ (left) icon. At a minimum, the roles currently assigned to the user creating the folder must have access.

6. Click Save to create the new folder.

To modify a report folder:

1. Click the icon to modify the corresponding report folder.
2. As desired, modify the folder name and description in the provided fields.
3. OPTIONAL: As a designated administrator of a User Group and from the Shared Reports area, specify restricted access to this folder based on a user's role. By default, all roles have access to the folder. To limit access:
   a. Select the Specific Roles option.
   b. Move roles between the Available Roles and the Roles With Access list-boxes by double-clicking on the listed role or by selecting the role and then clicking the ► (right) or ◄ (left) icon. At a minimum, the roles currently assigned to the user creating the folder must have access.
4. Click Save to commit the changes.

Changes are reflected in the Name column and the Last Modified column is updated to the current timestamp.

To delete one or more report folders:

1. Select the desired folder(s) by enabling its respective checkbox(es).
2. Click the Delete button.
3. Click OK to confirm the removal.

Note:
Deleting a report folder removes all reports stored within that folder. A backup copy of deleted reports is stored in the ..\Definitions\_Reports\_Backup directory before they are removed from the application. Imported reports will be deleted from being visible in the application interface but will not be deleted from the _Reports directory.
After creating a new report folder, move reports out of the root folder to make the workspace more manageable.

**To move reports into a folder:**

1. To move a single report, hover the mouse over the ➤ icon and select Move from the list of actions or select the report with the checkbox adjacent to the report name and click on the **Move** button. Multiple reports may be moved by selecting the reports and clicking on the **Move** button.

![Image of report folder interface](image)

2. **OPTIONAL:** From the *Organization* drop-down menu, select a user group. Organizations are not available by default. The administrator must have specifically enabled the Organization capability and created multiple organizations.

3. From the *Destination Folder Type* drop-down menu, select a folder type.

4. **OPTIONAL:** From the *Folder* tree, locate and select a folder to store the report in.

5. Click **Save** to move the report.
**Scheduling Reports**

The scheduling process is flexible and easy, offering the ability to deliver reports via email in HTML format, attached in a document (e.g., PDF, Word, Excel, CSV) or offering a link to the report in the archive directory on the server.

Scheduling reports is typically a two step process; 1) specification of when the report is scheduled to run and 2) identification of who should receive it (subscribers). From the Reports list page, the first time the *Schedule* action is invoked the user can create the schedule. After a schedule has been created, the *Schedule* action must be invoked a second time to get the list of schedules for the report and subscribe users to the report.

**Note:**
*Dashboards may not be scheduled.*

**Hint:**
*Contact the system administrator about being able to schedule reports.*

To schedule a report, hover the mouse over the ➤ icon and select *Schedule* from the dropdown list.

If a schedule already exists for the report, the *Schedules* page will be presented.

Click on the **Add** button to create a new schedule for the report.

Click on the **Delete** button to remove selected schedules for the report. Schedules may be selected by clicking on the checkbox adjacent to the schedule(s).
The Schedules list may be sorted by clicking on the *Frequency* or *Schedule* column headers.

The three actions available for a schedule are *Modify Schedule*, *Change Subscription* and *Run Schedule*. The *Run Schedule* option will not be presented until subscribers have been added to the schedule or if the report has expired.

Hover the mouse over the ▶ icon and select the appropriate action from the dropdown list.

Some or all of the following options are available when scheduling a new report:

- **Output Format**: Determines how the report is delivered in the email. HTML reports are embedded in the email and PDF, Word, Excel and CSV reports are sent as attachments.

- **Add to Archive**: checkbox is only visible when archiving is enabled by the System Administrator. If the **Add to Archive** checkbox is selected, the *Output Format* will be set to the default archive format specified by the System Administrator and the *Output Format* list will be disabled.

Reports can be added to the archive whenever the scheduler delivers the report. If the report is added to the archive, the email contains a link to the directory containing the archives. The report is not embedded or sent as an attachment but rather saved to the archive directory.
The following options are presented in the Schedule Task list (with the default set to Daily):

- Once
- Daily
- Weekly
- Monthly

As these options are selected, the subordinate gray dialog will either be hidden or present options pertinent to the scheduling option selected. If “Once” is selected, the gray dialog is hidden. Following are the respective dialogs:

Schedule Task Daily
Every [ ] day(s)

Schedule Task Weekly
Every [ ] week(s) on:
- Monday
- Tuesday
- Wednesday
- Thursday
- Friday
- Saturday
- Sunday

Schedule Task Monthly
- Day [ ] of the month(s)
- The [ ] Sunday of the month(s)
- January
- April
- July
- October
- February
- May
- August
- November
- March
- June
- September
- December

The Start Time specified determines the time when the scheduler will run the report. The hour and minute options are presented as drop-down lists.

The Start Date specified determines the initial date when the scheduler will run the report. The date may be manually keyed in or populated from the calendar control by clicking on the icon.
The **End Date** checkbox allows the user to let the report run indefinitely if unchecked. If the option is checked, the option to specify a date to terminate report execution is presented. Specification of the **End Date** is identical to the process for the **Start Date**.

The **Repeat Task** option allows a report to be run repeatedly, beginning at the **Start Time** and **Start Date** specified earlier. If the **Repeat Task** option is exercised, the **Interval** and **Duration** for running the report may be specified. The **Interval** determines the frequency and the **Duration** determines “for how long”. Both values must be greater than 0, and the **Interval** value must be less than the **Duration** value.

The initial scheduling page presented was for a report that did not require any user input. Following is a schedule page for a report that expects user input when it is run:

Since a scheduled report is run “unattended”, parameter values that would normally be supplied by the user (called “Ask” parameters) must be set at the time of scheduling. The scheduling page is adjusted to allow the specification of
the parameter values to be used when the scheduled report is run. Notice at the bottom of the schedule page a section labeled Report Input Parameters is presented.

Reports may have multiple parameters defined. Every parameter requiring user input must have values set. To set the values for a parameter, click on the icon and a Parameter Details dialog will be presented.

Clicking on the “helper” icons such as the and (when the parameter is date-based) may assist in selecting the values. Click on the Save Parameter button to save the values to be used for the associated parameter when the report is run.

When the scheduling options have been completed, click on the Save button at the bottom of the page to save the information and create the scheduled task.

If the Subscribed Users list is not present, then no users have elected to receive the report.

<table>
<thead>
<tr>
<th>User</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Admin</td>
<td><a href="mailto:Administrator@ACME.com">Administrator@ACME.com</a></td>
</tr>
<tr>
<td>Jim</td>
<td><a href="mailto:Jim.Smith@ACME.com">Jim.Smith@ACME.com</a></td>
</tr>
</tbody>
</table>

Subscribed users are listed at the bottom of the webpage.

**Hint:**

Test that the scheduled report is delivered as expected by first subscribing yourself and then running the report from the Scheduled Reports grid. The speed of delivery depends on the size of the report and the local network configuration.
Sharing Reports

Reports can be copied to the Shared Reports area for all users to view.

Copying reports typically involves selecting the reports to be copied and clicking on the Copy button. Single reports may be copied by clicking on the Copy action from the dropdown list of available actions for a report.

The New Report Name should be entered and the Destination Folder Type of Shared Reports selected. The option to select a folder within the Shared Reports area may be presented.

Click on the Save button to save the reports in the new destination.

Notes:
1. When a report is copied, the report’s name will be prefixed with Copy of (#) in order to distinguish them from the original. The "(#)") will only occur after a report is copied more than once.
2. An Expiration Date is used to designate when a time sensitive report is deemed obsolete. The date must be a date greater than the current date.
3. Any corresponding report archives are not copied with the report.
Modifying Reports

To modify a report or dashboard:

Reports and dashboards created in Ad Hoc can be modified using the Report Builder and Dashboard Builder respectively.

To modify a report, hover the mouse over the icon and select Modify from the dropdown list.

To rename a report or dashboard:

To rename a report, hover the mouse over the icon and select Rename from the dropdown list.

Modify the Report Name, Description and/or Expiration Date.

Click on the Save button to save the changes.
To delete one or more reports and the associated archives:

Select the desired report(s) and/or dashboard(s) by enabling its respective checkbox(es). Click on the Delete button to remove the selected reports.

Click the OK button to confirm the removal.

**Note:**
1. Deleting a report or dashboard removes the report from the Reports list.
2. A copy of deleted reports and dashboards are placed in the ..\_Definitions\_Reports\_Backup directory. Imported reports will be deleted from being visible in the application interface but will not be deleted from the _Reports directory.
3. Archives associated to the deleted report(s) will be deleted according to the setting specified by the System Administrator in the Application Settings webpage.

**Archiving Reports**

Archiving reports gives users the ability to retain copies of a single report as the report is changed over time. Reports created with a Logi Analytics tools are interactive and dynamic - the report data may change depending on when the report is executed or modified. A report archive stores copies of the report to retain important data.

**To add a report to the archive at runtime for report built with the Add to Archive option:**

1. Ensure that the Add to Archive checkbox is enabled in the Export Options tab.
2. Run the report and click the Add to Archive icon at the bottom of the report.
3. When the Reports list is refreshed, the View Archives action will be available for the report.
To view and manage an archived report:

To view archived reports, hover the mouse over the ➤ icon for the report and select *View Archives* from the dropdown list.

Click the *Archive Date* timestamp of the desired archive from the list to view the report.

Click on the ✉️ to email the archived report.

Click on the * Archived Date* column header to sort the list.

Click on the **Delete Archives** button to remove the selected reports from the archives. Archived reports may be selected by enabling the checkbox adjacent to the *Archive Date*. Confirm the deletion by clicking on the OK button in the confirmation dialog.
**Web Studio**

* This feature is not available in the Java version.

For the more advanced user, Logi Web Studio is available to create Logi Info based reports, modify imported reports and modify reports created in the Report Builder.

**Note:**
Once a report is modified in Web Studio, it may no longer be modified using the Report Builder.

**To create a report in Web Studio:**

1. Click the **Open Web Studio** button to launch the Web Studio interface.
2. From the Web Studio interface, click on the **Reports** folder and then using the left-mouse button, select the "Add > New Definition..." menu option.
3. From the Web Studio interface, construct the report definition.
4. From Web Studio's menu bar, click the icon in to save changes.
5. To exit the Web Studio interface and return to the application interface, click on any control in the application's menu bars (e.g., Reports).

**To modify a report in Web Studio:**

1. OPTIONAL: If desiring to modify a report created using the Report Builder which had never been modified in Web Studio before, then it is suggested to make a copy of the report before proceeding.
2. To modify a report in Web Studio, hover the mouse over the icon for the report and select **Web Studio** from the dropdown list.
3. Click **OK** to the "Are you sure..." warning message.
4. From the Web Studio interface, modify the report's definition.
5. From Web Studio's menu bar, click the icon in to save the changes.
6. To exit the Web Studio interface and return to the application interface, click on any control in the application's menu bars (e.g., Reports).

**Hint:**
Refer to the Logi Analytics Developers Network web site (a.k.a., Dev Net) at [http://devnet.logianalytics.com](http://devnet.logianalytics.com) for general help on using Logi Studio. For more specific help for a topic currently being used in Web Studio, click the icon in
the Information panel (lower left hand corner of the interface).
**View Dependencies**

Ad Hoc allows the user to view the various dependencies for the reports. The broad dependency categories are:

- Firm dependencies – items on which the report depends
- Loose dependencies – items that may be adjusted and still allow the report to run
- Firm relations – items that depend on the presence of the report
- Loose relations – items that may need the report to be present

To view the dependencies report, hover the mouse over the ▶ icon for the report and select *View Dependencies* from the dropdown list.

A fully collapsed view of a dependency page:

Click on the ▼ or the ▲ icons to expand or collapse a report section.
Dashboards are created by adding and configuring different panels. A panel is built with one of the following content types:

- **Pre-defined reports** - Canned reports that provide a quick view of a user's most:
  - Frequently Viewed Reports
  - Recently Viewed Reports
- **Favorites** - A user specified list of reports contained with a folder accessible from the My Personal Reports page.
- **URL** - Any valid URL the user has access to.
- **Reports** - A user specified report accessible from the My Personal Reports or Shared Reports pages.

Panels are organized into columns in the dashboard. A column may contain none to many panels but as a minimum, a dashboard must contain at least one panel to be saved.

The Dashboard Builder Panel Interface

![Dashboard Panel definition dialog](image)

The Dashboard Panel definition dialog
To add a dashboard panel:

An unlimited number of panels can be added to a dashboard. The panels can be configured to appear in the dashboard layout using panel settings and the panel drag feature controls provided.

1. Click the Add button to view the Panel Settings panel.
2. Type a Name and Description for the panel in the fields provided.
3. Change the Initial Column value based on where the panel should appear in the dashboard. The default value is 1.
4. Change the Initial Display setting based on:
   - Yes - display the panel at initial viewing of the dashboard (default).
   - No - do not display the panel at initial viewing of the dashboard.

Note:
If Initial Display = No, then the user has the option to add the panel via the Change Dashboard option within the dashboard viewer.

5. Adjust the panel Height. Default value is 300 pixels. The value range of possible settings is 10 to 5000 pixels.
6. Select the Panel Content type (default is Report).
7. Specify the report, folder or URL in the field provided.
   a. If Pre-defined reports, then select one of the listed reports and click OK.
   b. If Favorites, then locate and select a Personal Reports folder and click OK.
   c. If URL, then specify a URL address. Click Test URL to confirm that the URL can be viewed.
   d. If Reports, then locate and select a report located in the Personal Reports or Shared Reports.
8. Click Save Panel and return to the Dashboard Builder interface.
9. If the dashboard had not been previously saved, then type a name for the dashboard in the field provided.
10. Rearrange panels as necessary with the up/down arrows
11. Click Save to store the dashboard.

Hint:
The dashboard may be previewed at any time by clicking Preview Dashboard, as long as the Panel Settings panel is not being viewed.
To modify a dashboard panel:

1. Hover the mouse over the ▶ icon for the report and select Modify Dashboard Panel from the dropdown list.
2. Modify the panel as desired.
3. Click Save Panel and return to the Dashboard Builder interface.
4. If the dashboard had not been previously saved, then type a name for the dashboard in the field provided.
5. Click Save to store the dashboard definition.

To delete one or more dashboard panels:

1. Select the desired panel(s) by enabling its respective checkbox(es).
2. Click the Delete button.
3. Click OK to confirm the removal.
4. If the dashboard had not been previously saved, then type a name for the dashboard in the field provided.
5. Click Save to store the dashboard definition.

Note:
At least one dashboard panel must exist in order to save the dashboard.
To modify a Dashboard's Settings:

Click on the icon for the Dashboard Settings to expand the page and allow general dashboard appearance to be customized.

The Dashboard Settings panel, offers the ability to configure a dashboard's general appearance and provide an optional description. A panel's appearance is controlled by the selected Dashboard Style, which gives the dashboard a specific "look and feel". The available dashboard styles are:

- (None)
- Classic
- Gray
- Harmony
- LemonLime
- Light
- Mocha
- Nature
- Ocean
- Professional
- RedWine
- Technical
- Tropical

Notes:
1. The system administrator may add additional Dashboard Styles to this list.
2. The Dashboard Style will not control the appearance of any of the reports viewed in a panel.

As necessary, specify or modify the Description, Dashboard Expiration Date and header content.

Click the icon for the Dashboard Settings collapse/hide the Dashboard Settings panel.

Note:
The description appears under the dashboard's name in the Reports list in the Personal Reports and Shared Reports areas.
CHAPTER 14
Multiple Data Sources

Most Ad Hoc reports rely on a single data source. All of the display elements (display tables, crosstabs, and various charts) in the report would display data from that source. Logically this makes sense because analytical reports are typically used to make a point, tell a story, or reveal information about the data.

Ad Hoc is initially configured to accept data from a single data source; however, if the System Administrator discovers that reports need to reflect data from disparate data sources they can configure Ad Hoc to allow the end user to identify multiple data sources for a report.

**Note:**
In prior versions of Ad Hoc, the concept of report “Sections” accomplished this goal. This concept has been replaced by design. “Sections” of reports no longer exist.

If the System Administrator enables the “Multiple Data Sources” option, the Select or Modify Data Source dialog changes for all users as well as the Data Sources panel.

To create a new data source, click on the Modify Data Source button. The Select or Modify Data Source dialog is presented.
The dropdown list of data sources will appear at the bottom of the dialog along with a `Save as New` button. Select the data objects for the new data source from the data objects tree and click on the `Save as New` button. Enter a name for the data source in the `Save as New` dialog and click on the `OK` button to confirm it.

The `Data Sources` panel will reflect the new data source by having an entry in a dropdown list in the header of the `Data Sources` panel. This dropdown list may be used to assign a data source to a display element.

As data sources are selected from the dropdown list, the tree displayed in the panel content will be refreshed.

Every data-oriented display element in the report needs a data source. As they are added to the report definition, they will assume that the currently selected data source is to be used.
Users have the ability to create mobile reports from Ad Hoc. These reports are defined through the Ad Hoc Report Builder interface just as regular reports are defined.

There are a few limitations in the report definitions. Mobile reports are not permitted to contain:

- A Header element
- Export options
- The IDV element
- The Heatmap element
- Animated Charts

**Note:**
Regular reports can be either converted to mobile reports or copied and converted to a mobile equivalent. If, during editing, the mobile option is selected the user will be prompted to remove all of the above elements before the report can be saved as a mobile report.

**Note:**
If a scheduled report is converted to a mobile report, all schedules for the report will be removed when the report is saved.

**Note:**
Mobile reports may only be linked to other mobile reports. Links to normal reports will be removed when a mobile report is saved.

**Note:**
The System Administrator must enable the Mobile Reports option for non-administrative users by including the associated right in one of the user’s roles. Without the right the mobile mode option is not presented to the user.

When accessing mobile reports through a mobile device, the user may only view the report. Users cannot create, modify, copy, rename or delete a report from their mobile device. In addition, some home page considerations are basically ignored and the user is taken to the most logical report list based on their current home page settings.
The mobile device will only display the mobile reports and folders that contain mobile reports.

Only the Personal, Shared and Global reports areas are available from the mobile device.

Mobile reports are identified in the reports list with an icon. From a reports list the user would see:

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Customers</td>
<td>6/2/2011 2:47 PM</td>
</tr>
<tr>
<td></td>
<td>Customers - Mobile</td>
<td>6/23/2011 10:13 AM</td>
</tr>
<tr>
<td></td>
<td>Customers by Region</td>
<td>6/27/2011 10:36 AM</td>
</tr>
</tbody>
</table>
**Working with the Mobile option**

The Ad Hoc Report Builder interface offers a Mobile icon that toggles the mobile mode for the building and validation of a mobile report.

The 📱 icon indicates that the mobile mode is enabled. When the mobile mode is enabled the *Insert* and *Settings* ribbons will only show the display elements relevant to a mobile report.

Other differences between the normal and mobile mode include:

- The default *Paging Style* on the *Table Settings* and *Crosstab Settings* tabs is set to “Append Rows” for mobile mode and “Interactive Paging” for normal mode.
- Pixel widths for columns in mobile mode are removed. The table width is set to 100%.
- A resizer element is automatically added to display elements in mobile mode.

The 💻 icon indicates that the normal (non-mobile) mode is enabled.
CONTACT US

For more information about other Logi Analytics products or assistance beyond this user manual, please contact Logi Analytics in the following ways:

**Corporate Headquarters**

Phone: 1-888-564-4965  
(703) 752-9700  
Fax: (703) 995-4811  
Email: [info@logianalytics.com](mailto:info@logianalytics.com)  
Address: 7900 Westpark Drive, Suite A200  
McLean, VA 22102  
Web Site: [www.logianalytics.com](http://www.logianalytics.com)

**Sales Department**

Phone: 1-888-564-4965  
(703) 752-9700  
Email: [sales@logianalytics.com](mailto:sales@logianalytics.com)

**Customer Support**

Phone: 1-888-564-4965  
(703) 752-9700  
Link: [http://www.logianalytics.com/support/](http://www.logianalytics.com/support/)